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PRINT COST RECOVERY SYSTEM

About This Guide

Purpose of this Guide
This user guide is designed to provide user-friendly, detailed instructions for performing all tasks associated
with using the Abacus. This document attempts to communicate a certain level of detailed understanding

about Abacus and its system functions to the administrators. The document lists all activities and narrates
the entire process logic that will be built into the application.

Who should read this Guide
This guide is intended for administrator of Abacus product. This document helps the users to integrate

Abacus with third-party applications. The document also provides step-by-step procedures to retrieve data
from the third-party applications to the Abacus database.

How this Guide is organized

This guide is divided into the following chapters:

Chapter 1 — Introduction explains the overview of Abacus Manager and summary of how it works.
Chapter 2 — Abacus Activities explains how to filter activities, set filter and assign project information.

Chapter 3 — Abacus Projects explains the process of adding new project, changing project preferences
and importing project list from the existing database.

Chapter 4 — Abacus Reports explains the process of creating report and explains about custom report
and web report respectively.

Chapter 5 — Abacus Summary explains the process to search, remove, and create summary.

Chapter 6 — Abacus Devices explains adding, modifying, and tracking the devices and also explains how
to add copy terminals.

Chapter 7 — Abacus Media explains how to add and set media.

Chapter 8 — Abacus Paper Sizes explains the process to create, modify, and manage paper sizes master
list.

Chapter 10 — Abacus Pricing explains about Corp Code, Price Catalog, and Price Models.

Abacus Manager Version 3050
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Chapter 11 — Abacus Client explains how to add, delete, and import client.
Chapter 12 — Abacus Tools explains all the existing tools in Abacus.
Chapter 13 — Importing explains the process to import projects, windows users, and paper sizes.

Chapter 14 — Exporting explains the process of exporting data through ePremier, exporting activities and
projects respectively.

Typographical Conventions

Before you start, it is important to understand the typographical conventions used in this guide.

This Represents
Bold Menu, any option on the menu, radio button, check box,
command button or a link.
IC"\ A note, providing additional information about a certain topic.
o
A An important message not to be ignored.

Abacus Manager Version 3050
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How to Get in Touch

The following section provides information on how to obtain support for documentation and software.

Documentation Support

For any questions, comments or suggestions on the documentation, contact us by email at
abacussupport@mirrorplus.com

Technical Support

If you have any problems, questions or suggestions regarding this software, email us at
abacussupport@mirrorplus.com. While contacting technical support, please have the following information
ready:

= Abacus version
= The operating system
= A description of the steps leading to the problem

= The exact message that appeared when the problem occurred, or any other message that
appeared on your screen

For additional information:
Please contact: MirrorPlus Technologies Inc via email, and / or phone:

Email: abacussupport@mirrorplus.com

Phone: 1-877 TRY ARCL1 (Option 2 for Abacus Support)

WWwW.mirrorplus.com

Abacus Manager Version 3050
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Chapter 1- Introduction

Product Overview

The Abacus Print Cost Recovery System is designed to provide unattended tracking and reporting of all
printing and plotting requests for an AEC office.

Using the system, you will be able to provide billing data for your clients on a project by project basis, so
that you may properly assign costs associated with printing to an individual project, and also, to provide
you with the information necessary to bill your client for reimbursable expenses incurred when plotting or
printing. You can also collect data on print requests, which are not assigned to a particular project, in order
to better help you to manage the overhead costs associated with printing and plotting activities which may
not be reimbursable.

The Abacus Print Recovery System is composed of several modules which have been installed for you on
your network. Your reprographics provider has preconfigured much of the system based upon information

that you may have provided them; however there will be an ongoing need to keep the system up to date so
that it will continue to provide you with accurate information for your printing activities.

How the system works

Each time a print or plot is sent by a user on your network, the Abacus Tracking Server will intercept the
print request, and trigger a billing pop-up for the user to fill out which will contain information regarding the
project, the print media, and the reason for the print.

Once the information has been entered, the data will be added to the Abacus database, where you may
access it to prepare reports on your printing activity.

Several applications are involved in this process, and have been preconfigured for you by your
Reprographics provider. Here is a summary listing of the applications involved, and a short description of
what they each do:

Abacus Core Components

Abacus Database: The Abacus Database automatically collects project and print information each time a
user on the system prints a document to a printer. The database records information relating to the date
and time of the request, the user, the project and project phase, as well as the media type, size and
number of copies requested. This information is used by the Abacus Manager and reports to provide you
with a variety of reports tailored for your individual billing needs.

Abacus Manager Version 3050
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Abacus Server: The Abacus Server is IIS based multiuser component that provides communication with all
other Abacus components. Whenever a print job is submitted by the user, Abacus Server stores some
detailed information to log files. Abacus Server runs Dispatcher Service for prompting a billing popup for
the user whenever the user submits a print.

Abacus Data Scheduler: The Abacus Data Scheduler which runs on the server allows creating,
modifying, and scheduling the data import jobs, Repro Desk jobs, KIP log files jobs, OCE Account center
jobs, etc. The Abacus Data Scheduler runs all the jobs scheduled at regular intervals based on the job
schedule. To run the scheduled job, Abacus Schedule service should be running at all times.

Client Components

Abacus Tracking: The Abacus Tracking is responsible for intercepting and interpreting print requests
submitted by users on the network. The Abacus Tracking component usually runs on the Print Server on
the network. As the user submits a print request, the print data is examined by either the Windows Print
Notification System or the Abacus Print Processor. This information is then written to Abacus Database by
Abacus Tracking. The Abacus Tracking can be installed on multiple computers based on the
requirements. The Abacus Tracking can also be installed on a workstation computer to track the local
printers, which are not able to track from the Print Server.

Abacus Billing Popup: The Abacus Billing Popup is a service, which runs on each workstation in the
customer’s network. Each time a print is requested the Abacus Billing Popup window will pop-up and
provide the user with menu options allowing them to reference a particular project and billing purpose for
each print that they produce.

Configuration Management and Reporting Component

Abacus Manager: The Abacus Manager provides the system administrator with the ability to set up
projects, printers, users and media information for tracking. This component can be accessed by anyone at
the customer site with a valid user ID and password. The Abacus Manager will also allow you to configure
all printer / user permissions on the system and prepare reports on your printing activity.

Data Collection and Consolidation Components

Abacus Central Database: The Abacus Central Database runs on a server located at the Reprographers
office. Abacus can be configured so that billing information from the client office will upload to the Central
Database automatically.

Abacus Central Server: The Abacus Central Server allows the hosting reprographer to connect to, and
consolidate billing information from client offices running the Abacus Cost Recovery system.

Of these applications there are only two which will require your attention. These are the Abacus Manager,
and the Abacus Billing Pop-Up. This document focuses on the Abacus Manager. The Abacus Billing Pop-
Up is detailed in the “Abacus User Guide”.

Abacus Manager Version 3050
10 of 170
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Using the Abacus Manager

The Abacus Manager is generally installed on a single workstation within your office network. This
workstation should be the one which is normally available to the Abacus Administrator. To launch the
application on that machine, go to the Start Menu, select All Programs, and find the folder named “Abacus
Manager”. Inside this folder, you may click on the application labeled “Abacus Manager” to start the
application.

Administration]

B Abacus

* Manage Activities

e

Figure 1: Abacus Manager (Administration) screen

Abacus Manager Version 3050
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Setting up the Abacus Manager

Before you begin using the Abacus system for print tracking, populate the database with the specific
project and user information that you would like to assign to the print requests.

There are several areas which you may need to define:

Clients
Projects
Phases
Departments
Users
Devices
Media

Paper Sizes

Pricing

Navigating through the Abacus Manager Windows

Most of the Windows in the Abacus Manager are broken into two halves. The left side is generally a listing of
items which have already been defined, and the right side is an edit window which will allow you to modify the
attributes for the selected list item.

Abacus Manager Version 3050
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& Abacus Manager - [Untitlad] [= [
I Fle Yiew Toos Help
i tiew Ed Delete | & Refresh ﬂiavs | m

2D

fome [ = & Projects

E S] Test Project

@ Saue Changes... Delete this Project..

Achivity

-~ Project Name Test Project

b

LS prject Nmber

Prajects

¥ active status

H=

=

Sektings Client I | [ select Client |
Reparts Department ‘ ‘ ‘ Select Deuartment‘

\9 Price Catal o ]

Uy rice balng HONE

Description NOMNE

Devices

% Default Billing Code  Mon-Reimbursable

Media ' Reimbursable

© Hone
%
d
Paper Sizes -
Other Settings I™ Lock Billing code selection for this project

Pricing Number Name Active IsDefault

% Add New Phase|

Clients

Save Changes... Delete this Project,.,

Figure 2: Abacus Manager Window

Most of the lists in Abacus Manager have advanced menus associated with them which can expose
advanced options. To activate the Advanced menu, right click on the main item, or any individual list item to
display the menu.

As you define the main items in Abacus, you need to save your changes as you go along in order to insure
that they are properly recorded into the database.

Abacus Manager Version 3050
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Chapter 2
Abacus Activities

For each print request that is captured by the system, a complete record of the request is stored in the
Abacus Database. These records can be viewed, edited and sorted in the Activity window.

Accessing Activity screen

Follow the given procedure to access the Activity screen.

Click View >Windows >Activity from the main menu or click | A& | from the icon bar of the Abacus

Home Page. The Activity screen appears.

5% Abacus Manager - [Print Activit

Page 1 of 1, Total#: 24]

t File

i@ ew K osete | & refresh ﬂsava

Yiew  Toals

Help

g Job | Type ‘ Project | Department Phase Device Media Pricing Copies | Originals | Width ‘ Length ‘ BillCode |T_
‘ﬁ 1 |rest Page |an Test Project2 Construction  |Usryabhatalis Letter Shest 1 1 8.00 10.69 Non-Reimbur 100 | FilterBy Basic © Advanced
e 2 |TestPage  Print Test Project? Construction | Varyabhatalde nfa 1 1 .00 10.69 1.00) ‘ al J

3 |TestPage  Print Test Project! Congtruction | Varyabheta s Bong Sheet 1 1 3.00 10,69 Reimburgabl 1.00)
Choose or Enter Criteria below
4 |TestPage  |Print Test Project! Construction | UaryabiatalCzBoned Sheet 1 1 8.50 11.00 Reimbursable 1 00|
5 |TestPage |Print Test Project! Design aryabhataCs Bond Sheet 1 1 8.50 11.00 Reimbursable 1 00| [ Indude Billed/ Closed items also
B |TestPage |Print Test Project! release aryahhataiCs Bond Shest 1 1 850 11.00 Reimbursable 1 00|
5 - I” Apply Nested Filters
7 |TestPage |Print Test Project! Design aryabhataiCs Bond Sheet 1 1 850 11.00 Reimbursakle 1.00]
(search on filtered results)
8 |TestPsge Print Test Project! Waryabhatalde nfa 1 1 800 1063 Reimbursakle 1.00]
9 |TestPsge Print Rert.com aryabhataldes Letter Sheet 1 1 8,00 1068 1.00] Apply Filter
100 | Test Page  Print Rert com \aryabhatalis Letier Shest 1 1 5.00 1063 Reimbursagle 1 oo | Clear Filter
11 |TestPage  Print BNV Matoren Construction DivDesign FM | Uaryabtiatati=Bond Sheet 1 1 8.00 1069 Reimbursable 1. 001 Manage Filter Criteria
42 |TestPage  Print BMY Motoren Construction Div Uaryabhatalie nfa 1 1 .00 10.69 .00} Filter Status: 9/2/2009 to till Date
13 |TestPage  Print Test Project! Construction | Varyabhata{=Bond Sheet 1 1 .00 10.63 Reimburzakl 1.00)
- R Make Changes to data
14 |Test Page  |Print Test Praject! Construction | VaryabhatalCe nfa 1 1 3.50 11.00 Reimbursable 1 00| Enter Manual Activity
15 |TestPage |Print Test Project! Construction | VaryabhatalCe nia 1 1 850 11.00 Reimbursable 1 00} Refresh Data
16 |TestPage  |Print Test Project! Construction | UaryabfatalCs nia 1 1 850 11.00 Reimbursable 1 00| Export Activity Data
17 |TestPage  |Print Test Project! Construction | UaryabhatalCs nia 1 1 850 11.00 Reimbursable 1 0}
18 |TestPsge  Print Test Project! Construction | VaryabhataldeBond Sheet 1 1 800 1063 1.00)
- 19 |TestPsge  Print Test Project! Construction | VaryabhataldeBond Sheet 1 1 3.00 1063 100 View Dptions
20| Test Page  |Print Test Project] Construction | Varyabhiata)Cs Bond Shest 1 1 .50 11.00 Reimbursakle 1 00f | First Page
! 0| Test Page |Prit Test Praject! Construction | VaryabhiatalCa Letter Sheet 1 f .50 1100 1.00) :“t_"““:
i revious Page
Vi 590 Test Page | Print Test Praject! Canstruction | VarvabhataCz Bond Sheet 1 1 550 11.00 Reinbursable 1 00f (DD 9
Devices 23 |TestPage  |Print Test Project! Construction | VaryabhataCs Letter Sheet 1 1 .50 11.00 1.00) 1 j
24 |TestPage  [Print Test Project! Construction | VaryabhataCs Letter Sheet 1 1 .50 11.00 Reimbursakl 1.00)
i Options
w Set Columns to Display
Paper Sizes Mote: Right Click on columnn headers to
sort Ascending! Descending
Pricing Hote: Select multiple and Right Click to
change multiple Adivities
Clients:
Save Changes...
4 | v =

Figure 3: Activity screen

The Activity screen is split into two frames: the Activity List on the left hand side and the
Activity Options on the right hand side.
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You can remove the Activity Options frame in order to get a wider view of the data in the Activity list by

clicking (Show/Hide icon) below the main menu.

There are several tools available to the Abacus Administrator that helps you to view and update the
information stored in the Activity section of the Abacus Database.

Filtering the Activity list

You can filter the activity list by:

= Project

= Device

= Media

= Billing Code
= Date

=  Type

= Tracking Mode

= Job Status

= Users

= Machine Name ( Print Form)
» Department

= Location Key

=  Provider Key

= Data Scheduler Job

This makes it easy for you to find all the records for a given project and this enables you to quickly review
the records and helps you to find out any missing information prior to billing.

Setting Filter
Follow the given procedure to set filter for the activity list.

1. Select Basic or Advanced option from the Filter By field.
If you select Basic:

a) Select the criteria to filter by from the given drop-down list.

Abacus Manager Version 3050
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The procedure is same after this for both the Basic and Advanced options, so we will discuss it at the end

1(‘ - of this section

If you select Advanced:
b) Select the Start Date and the End Date from the calendar displayed. This enables you

to review activities by a date range.

c) Click Select Project. The Select Project window appears.

X

Select Projects
Select Projects

Filter Dptions
" Select Fram List ™ Unazsigned

{* Select Al
Selected Filter ltems

Available [tems
Projecks

Projects
[] Erticson
[] Mac Herax

[] San Diego

=
=

% L5

Find | Clear
#:3 #:0
Select | Cancel

Figure 4: Select Projects window

From the Filter Options section, select either Select All option or Select From List

i.
option or Unassigned option.
Select All — If you click Select All option, all the projects within

the list of Available Items get selected.

Abacus Manager Version 3050
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= Select From List — If you click Select From List option, you
can select the check boxes adjacent to the projects name from

. . . 53
the list of Available Items and click and the selected
projects get added within the list of Selected Filter Items.

= Unassigned — If you click the Unassigned option, the list of
unassigned projects are displayed within the list of Available
Items. Select the check boxes adjacent to the projects name

>

from the list of Available Items and click J and the
selected projects get added within the list of Selected Filter
Iltems.

ii. Click Select. The selected projects get included for which you can apply filter.
d) Similarly, select Devices, Media, Billing Codes, Users, Departments, Print From, Location
Key, and Provider Key.
2. Select Include Billed/Closed items also check box if you want to include the billed/

closed items in filter.

3. Select Apply Nested Filters check box if you want to apply nested filters in the search
items.

4, Click Apply Filter to apply the selected filter for the search item.
To reset the activity list so that it will display all records, click Clear Filter link.

6. To manage the filter criteria, click Manage Filter Criteria. The Manager Filter Criteria
dialog box appears.

Abacus Manager Version 3050
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Manager Filter Criteria [5_(|

Save current filter critena
M ame |I'-.-1.a|: Hero Save

Manage exizting filkers

Erriczan
San Diego

Delete Load Filker Criteria |

Cloze

Figure 5: Manager Filter Criteria dialog box

a) Enter the current filter criteria in the Name text box and click Save. The filter criteria get
included within the Manage existing filters list box. To delete any criteria, select the
filter criterion from the list of Manage existing filters and click Delete. The filter criterion
gets removed from the list.

b) Click Close to close the dialog box.

7. From the Make Changes to Data section, you can enter manual activity to database,
refresh data, and also export the activity data.

Entering Manual Activity to the Database

If you have run copies or generated copies from a scanner that are not being viewed on your network, you
may wish to enter this information manually into the database in order to produce a comprehensive billing
report for your Client..

1. To add a manual Activity, click Enter Manual Activity link from the options frame, and
the Manual Activity window will appear.

Abacus Manager Version 3050
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Manual Activity
= Register Manual Activity
Redgizter Manual Activity

Job details
Job Mame * Job Type *

[Print 2008 [Pt =l
Status

|Biled |

Billing Information
Project List* [ Enable Search Phase List

|Erricson ﬂ | j

Custarn Field

X

Biling Code *
| Reimbursable j

Originals Uszer Mame Date

[1 cin | |03/03/2010 011515 PM ¥ |
Notes *

Pricing

CorpCode | UnitPrice | TotalCost &
Cost |-
5339

Eharae I

-

< | v

Frinter and Media Settings Add Cancel |

Figure 6: Manual Activity window

2. In the Job details section:

a) Enter the job name in the Job Name text box. (Mandatory field)
b) Select the job type from the Job Type drop-down list. (Mandatory field)
c) Select the status of the job from the Status drop-down list. (Optional)

3. In the Billing Information section:

a) Selectthe Enable Search check box to allow exploring.
b) Select the project from the Project List drop-down list. (Mandatory field)
c) Select the phase from the Phase List drop-down list. (Optional)

d) Select the billing code for the job from the Billing Code drop-down list. (Mandatory field)

Abacus Manager Version 3050
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€) You can enter the quantity of the original prints and user name in the Original Prints
and User Name text boxes respectively. (Optional)

f)  Select the date / time when the print was given from the Date drop-down list. (Optional)

g) To allow the system to track your costs and charges, enter the required information in
the Pricing section.

h) Click the Printer and Media Settings to establish the advanced options like, printer,
media selection, paper size, machine name, and number of copies from/in the relevant
fields and click OK.

Advanced Options PE|
Device Mame
|Rich Aficia 2030 ~|
Media
|Bond ﬂ
Width (Inches) Length (Inches)
12 [14
achine / Ref Hame No of Copies
INDTAPPLOS2-2 1
Ok | Cancel |

Figure 7: Advanced Options dialog box

4, Click Add to add the manual activity details and the data gets recorded in the database.

s Abacus Manager - [Print Activity - Page 1 of 1, Tatal#: 75]

Figure 8: Manual Activity screen

Refresh Data

= Click Refresh Data to display the activity that you have entered manually on the ‘Activity
Screen’.
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Exporting Activity Information

You can use third party software system for billing or storing your print activity information. The Abacus
Manager provides a simple means to export the data from its database into a delimited file for import into
another system.

1. Click Export Activity Data and the Data Export Job Details window appears.

Enter Data Export Job Details g|
Create new data export job
@ Erter job name and select export data type

Job details

Job Name
Export Data

Activity Pricing

[ Include Pricing with Acitivity

iZorpiCode Mame
|l Cost
[ 3332
| I[charge

| Mest » Cancel |

Figure 9: Enter Data Export Job Details window

2. Click Next to continue. The Export Option Page window appears.
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Create new data export job
t Select column name
Export Fields
| Colurnn Name | Select Al
¥ Project Number
[¥] Project Name Clear Al
¥ Project Description
vl Client Company Name Mave Up ‘
¥ Default Eiling Code =
v Active Status Oveonn.
¥ PriceCatalog
V| Default Phase Sort
¥ Department Coln
Active Status =
Order
AT -
Mote: Last columns will be pricing columns.
< Back | Next > | Cancel |

Figure 10: Export Option Page window

3. Select the check box adjacent to the fields that you want to export from the Export
Fields list box. You can click Select All to select all the fields within the Export Fields
list box. Click Clear All to deselect all the selected fields within the list box. You can click
Move Up or Move Down to change the field’s place.

4, Select the column from the Column drop-down list that enables to make the exported
data fit within other reports without modifications.

5. Select the sort order from the Order drop-down list.

6. Click Next to continue. The Export Settings Page window appears.
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Export Settings Page

X

! Create new data export job
@ Ertter File Information, Export Options snd Fikers

Export File Information
File Path

|C:\F‘rogram Files\Abacus -
File Name |Abacus
User Authentication

Export Options

Colurnn D elimiter CSY Delimiter -

™ Replace Column Delimiter with spaces
Iv Column Headers

Fow Delimier Hew Line v
Column specifier e -

Filter

¥ Active Projects Orly

< Back | Mext > | Cancel |

Figure 11: Export Settings Page window

From the Export File Information section, enter the file path in the File Path box or click

~_1 (browse button) to select the file path from the Brose for Folder dialog box.
8. Enter the file name in the File Name text box.

To verify user authentication, click User Authentication. The User Authentication
dialog box appears. (Optional)

User Authentication le

Please enter the user credentials to access the netwark resouce

Domairt sermame

|F‘au| Feset

Pazsword

Test Connection | Save Cancel |

Figure 12: User Authentication dialog box
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=  Enter the valid user credentials in the Domain/Username and Password text
boxes respectively and click Save to save the settings.

10. From the Export Options section, select the column delimiter from the Column
Delimiter drop-down list. You may select CSV, Tab or Custom Delimiter format for
compatibility with a third party application and set options for row and column settings.

11. Select Replace Column Delimiter with spaces check box to replace the column
delimiter with spaces.

12. Select Column Headers check box to set the field names into your file as the first row of
data.

13. Enter/select the row delimiter and column specifier in/ffrom the Row Delimiter and
Column Specifier box. Column Specifier will specify each column with the symbol
indicated in the box. E.g.(*).

14. Select the Active Projects Only check box to export the active projects only.

15. Click Next to continue. The Finish Job window appears.

Finish Job X

! Finizh Export Job
@ Click Finizh to Save Export Job

Job Information

Name: (K= Export Data:  Projects

File Information
Col Delimiter - C5% Dielimi Row Delimiter Mew Ling

Col Headers =

Path: D:ASabarni GuhahaRC_Task\Abacus
Sarting Order Sorting Column
Selected Fields

Source A

Schedule Information

Not Scheduled

Advance Option

< Back | Finish | Cancel

Figure 13: Finish Job window

16. Here, you can check the Job Information and File Information of the Project that you want
to export.

Abacus Manager Version 3050
24 of 170



-
—
Abacus

PRINT COST RECOVERY SYSTEM

17. Click Advanced Options to configure pre and post program execution. The Pre & Post
Program Execution dialog box appears as shown.

Configure Pre & Post Program Execution ﬁ]

[v PreJob Execution Option

(" External Program |D: YWSabarni Guha'ARC_Tazk\Abacuszscreenshabacus

™ Abacus Job | J

[v Post Job Execution Options

(+ Esternal Pragram |D:\Sabarni GuhatARC_Taskhbbacuzh3050%8bacusdd IZI

™ sbacus Job | J

Configure | Cancel |

Figure 14: Configure Pre & Post Program Execution dialog box

Select the required options.

= |f you want a particular job to be executed before other jobs, select the Pre Job
Execution Option check box and select the required option. The options are
External Program and Abacus Job. You can choose either of the two options
and select the external program path or the Abacus job as per your requirement.

= If you want a particular job to be executed before other jobs, select the Post Job
Execution Options check box and select the required option. The options are
External Program and Abacus Job. You can choose either of the two options
and select the external program path or the Abacus job as per your requirement.

18. Click Configure to configure the settings.

19. Click Finish in the Finish Job window after completing the required data entry.
View Options
Your Activity list may grow to be quite large, and will need to be represented in Pages.

The title bar of the Activities window will display the current page number being viewed and you can
navigate between pages by clicking either the Next Page or Previous Page links.
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Setting the display options for the Activities List

In some instances, you may want to view only certain columns in the activities list or you may prefer to
change the number of items per page in the display.

1. Click Set Columns to Display to modify the display options. The Activity Display
Options dialog box appears.

Activity Display Options g|

Dizplay Selected columnz

Calurnn Narne: ”~
Jobhame

Move Up |

rojectMName
! Move Down

Wl Lacationkes i
< >
Activity page size; 1000

Figure 15: Activity Display Options dialog box

a) You can select or deselect the check boxes adjacent to the column names to turn on and
turn off any given column in the display.

b) Set the number of items to be displayed per page.
c) Click Save to save the settings.

2. Click Save Changes to save all the given information.
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Making Changes to the Activity List

Before you create a billing report for a client or approve your activities list for billing by your reprographics
provider, you may want to review the billable options in your activities list to insure that they are recorded
correctly. In some cases, users may have elected not to assign a print request to a project, or they may
have failed to properly select a media type. You can enter or change many of the billable parameters
directly from the activity list.

CreateDat | PrintBy | MNotes |PrintFrom |JobStatus
1722009 1 &dimin | Manual Activ] Aryabhiata M'
002562009 Zsuchakar  |Client Reguesaryabhata | AqPending
1072862009 1 suchakar | Design Reviearyabhats | A(VVeEnd
1002702009 3zudhakar | Design Reviearyabhata AW
1062772009 1 sudhakar | Conatruction aryaihats | A¢gen
1072702009 1 suchakar | Construction | arvabhata | AlVerified
1002712008 1 suchakar | Desion Reviearyabhats | 4qSosed

Figure 16: Activity List

All the Activities must be approved before they appear in a report. This is a manual activity and can be
performed by selecting the appropriate option from the drop-down list. Example: In the Job Status
Column you can change the status from Pending to Accepted.

You can copy the “Accepted” value to all the visible entries on the page. For this right-click on the Accepted
value and select the required option from the Copy Down tools:

= Select the Apply Down Empty to copy the value to all items below, that were not previously
defined.

= Select the Apply Down option to copy a chosen value to all items that exist below it in the
active page.

# \ When using the Copy down control to assign project or media information to a range of activities in the

I\ - Activity list, the copy down function will only affect items which are listed on the current page. This
behavior is by design, and when used in conjunction with the Filtering options will allow you better control
of how you assign properties in bulk.
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Joly Type Project |
Tes=st Page Frimt le=t project
Test Page Frimt [ projectl -
Tes=t Page Primt
Tes=t Page Primt
Test Page Primt

Figure 17: Activity List

In the list above, several print jobs are missing their associated Project information. You can discover by
reviewing the information in the activity list that all the activities belong to a single individual on your
network, and you may know that this individual is only assigned to one project. Here you can use the filter
control to filter the list by this one person, and then assign the first activity to their project by selecting
appropriate option from the drop-down list in the projects column.

Once you set the project information for this activity, you can also copy it to all of this persons print jobs. To
do this right-click on the project name and click Apply Down from the pop-up menu.

Click the Apply Down option to copy a chosen value to all items which exist below it in the active page.

You can also select Apply Down Empty option to copy the value to all items below which were not

previously defined.

Hotes PrintFrom

hanual Activ Arvabhsata
Client Regues aryabhata
Deszign Reviearyabhata
Dezign Reviearyabhata
Construction|aryabhata
Construction|aryabhata

Dezign Revie arvabhata
arvahhats

JohStatus | ModifyDat | ModifyBy
Accepter — 14 2 eomme 42 n i,
Accepted Apply down Empby
Accepted Apply down

Accepted

Accepted Filker by JobStatus
Accepted Cancel Filker

Accepted Madify Multiple Items

N rrenterd

Figure 18: Pop-up options in Activity List

Any time you change information in the options list, the database will track the last date and time and will
find out item that was changed and who had changed it.
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Click Modify Multiple Items option to update the multiple activities at one time. For this, select the required
check boxes to enable the required fields and select the appropriate option from the given drop-down lists.
You can provide Project Information, Media and Billing Codes, Global Phases information, Status and

Comments information here for the Activity.

Update Multiple Activities

M= ] Update Multiple Activities
Update Muttiple Activities ot one time

Selected Activity Count: 1

~Media and Eilling Code:
v Update Media

i~ Project Information

¥ Update Project / Phase Enable Search v

[Evricsen =] [Bond =
Phaze I~ Update Biling Code

| [E] I =

~ Status and Commert - Mizzellaneou:

¥ Update Hotes 0oz ~ | Update Global Phazes

lChEﬂt Request L] [~ Update Custam Fields
I~ Update Job Status

I =l

Update I Cancel |

Figure 19: Update Multiple Activities dialog box
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| Save Changes...
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Figure 20: Unmapped items (Yellow column)

Mapping the Unmapped item

Follow the given procedure to map the unmapped item.

1. Select the unmapped items from the Activity list.

2. Right-click on the column and click Show Unmapped ltems from the pop-up menu.
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Figure 21: Show Unmapped Items menu

The Unmapped Items for Selected Activity window appears.

Upmapped ibems for selected activity

Pioiests | Phases | Papes Szes  Meda | Bilingoades | Devices |

Unmapped Nems
Actrebes with uremepped media bems

~ Urmapped Madia

If Media plamaton bilked onimpoited Actvity dossnol exist in the Abacus
Media izl t vl be added a5 &n unmapped Media and the user ic gven an

eppoilunty o add the sichaned Meda o Abscus Media s

 1Bod

—Selaction

Selectéll | e Selecton

Delste sslected |

Re-mep above selected mediax] to an existng media selecled below

Fe-map Media

-

ok |[ cence |

Apoly
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You have to search through individual tabs. If the information billed on imported Activity does not exist in
Abacus, the item will be added as unmapped item.

Find the item that is not mapped to Abacus Activity.

Select the unmapped item.

Select the existing item to re-map the unmapped item.

Click the Re-map button.

N o o M w

Click OK. The unmapped items gets mapped to the existing item.
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Chapter 3
Abacus Projects

The Abacus Manager allows you to get all the information of the running projects.

Accessing Projects Screen

Follow the given procedure to access the Projects screen.

Click View >Windows >Projects from the main menu or click | "= " from the icon bar of the

Abacus Home Page. The Projects screen appears. The Projects screen is divided into two frames: The left
hand frame lists the Projects Name and the right hand frame displays the detail report of the specific option
as selected from the list.

3% Abacus Manager

P Fle View Took Hep

2 New E3 Delete | 4 Refresh BSEVE | Bf]

Save Changes.. Delete this Project..
i - .
Project Name Test Projectl
Home = ﬁ Projects
@
[ Test Project2 W active status
Ackivity
bt "
\.E client [ | [ Select Cliert |
Projects
A=
E{E Department ‘ | | Select Department |
Settings
!; Price Catalog FM Billing hd
Reparts
Description MOKE
9
Summary
Default Billing Code " Neon-Reimbursable
i ® Reimbursable
Devices © Nane
% Other Settings [” Lock illing code selection for this project
Media
jé. Number Name Active |IsDefault
Paper Sizes " None
@ el |[0nt | [Construction | W o
Fricing sl |[002 | [Design | i o
% Add New Phase|
Clients
Save Changes.. Delete this Projact...

Figure 23: The Abacus Project window

Abacus Manager Version 3050
33 of 170



0
—
Abacus

PRINT COST RECOVERY SYSTEM

Prerequisites: Several items are to be defined before you can properly set up a project in Abacus. These
include:

= Project Name

=  Project number

= Client

= Departments

= Price Catalogues

= Default Billing Codes

If these were not been defined, please refer to those sections of this manual first, before you enter a
project in the system.

Adding a New Project to Abacus
Follow the given procedure to manually add a new project in Abacus.

1. Right-click on the Projects from the project list and click Add New Project from the
option.

:I d Mew Project

_ﬁw R

Import Projects
Export Projects

Switch ko Deparkment Project Yisw
Project Tree Display Options

Figure 24: Add new Project option

The Add New Project dialog box appears.

OO MNEW

Erter Project Mumber

|5341 3

Erter Project Mame

|5an Dieqo
V¥ Active

Add Cloze
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Figure 25: Add New Project dialog box

2. Enter the project number in the Project Number text box.
Enter the project name in the Project Name text box.

4. Click Add. The project gets added under Projects list. The project editor will display with
additional options for this project. The Project Editor will allow you to associate several
data fields with a particular project. These include:

= Project Name — User entered Text, Required field

= Project Number — User entered Text, Required field

= Client — Selected from previously defined Client, not a required field

= Department — Selected from previously defined Department, not a required field

= Price Catalog — Selected from previously defined Price Catalogue, not a
required field

= Description — User entered text, not a required field

= Default Billing Code — User can select a Billing Code from previously defined
Billing Codes, not a required field.

= Project Phase - Selected from previously defined Phase, or may be entered
specifically for this project, not a required field

5. Select a default billing code. All the print requests for this project will be pre-set to the
default code. Users may change this code when they set up their print request however.

6. Select the Active Status check box to set the project as active. Active
projects will show in the billing pop-up, and will be displayed in the project
list with a yellow folder. Inactive projects will not appear as choices in the
billing pop-up, and will appear in the project list with a red folder.

7. In the Other Settings section, you may define the phase list for the project. To do this,
click Add New Phase link to define phase names and descriptions as per requirement.

8. Click the Save Changes link to record your new information to the master database.
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Changing Project Preferences using Project Editor

You can change the project preferences globally using the Project Editor window. These changes can be
either global or based on the projects that you select.

1. Click | F"E5 7 trom the icon bar of the home page of the Abacus Manager. The Project
Editor window appears.

Total Projects: 1

Select Project:

| Select Projects |
filter: All

|Pau| Mac j

| Apply Client |

Select Client:

Salect Billing Code:

| Reimbursable |

| Apply Biling Code |

Select Department:

Cesign j
Apply Department |
Select Price Catalog:
MNone j
| Apply Price Catalog |
Select Global Phases:
| Design =]

¥ set 2= defzult Phaze
| Apply Global Phases |

| Restore Default Phase | | Apply InActive |

| Apply Delete | | Apply Active |

Figure 26: Total Projects screen
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2. Select project(s) for which you want to apply the settings. To do this:
a) Click Select Projects. The Select AddUpdateProjects window appears.

Select AddUpdateProjects
Filter Dptions
" Select Al &+ Select From List " Unassigned
Available ltems Selected Filter Items
AddUpdateProjects AddUpdateProjects
[] Erricsan [] San Diego
[ ] Mac %erax
>3
<4
< ¥ < ¥
Find | Clear
f:1 #:2
Select | Cancel

Figure 27: Select AddUpdateProjects window

b) From the Filter Options, select either Select All option or Select From List option or
Unassigned option.

= Select All - If you click Select All option, all the projects within the list of
Available Items get selected.

= Select From List — If you click Select From List option, you can select the
check boxes adjacent to the projects name from the list of Available Items and

3
click and the selected projects get added within the list of Selected Filter
Items.

= Unassigned — If you click the Unassigned option, the list of unassigned projects
are displayed within the list of Available Items. Select the check boxes adjacent
. . . . >
to the projects name from the list of Available Items and click and the
selected projects get added within the list of Selected Filter Items.

c) Click Select. The selected projects get included for which you can apply settings.
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3. Select the client name from the Select Client drop-down and click Apply Client.
Similarly, select Billing Code, Department, Price Catalog, Global Phases from the
specified drop-down lists and apply the selections. The changes are applied to the
selected projects or all the projects based on the filter.

4. Click the required buttons.

= Restore Default Phase: This allows you to set the default phase for the selected
projects.

= Apply InActive: This allows you to set the project status as Inactive for the
selected projects.

= Apply Delete: This deletes the selected projects from the project list.

= Apply Active: This sets the project status as active for all the selected projects.

Advanced menu items in the Project List

At the Root level

Add Mew Project l

Impork Projects
Expork Projects

Delete all Projects

Switch to Department Project Wiew
Project Tree Display Options

Figure 28: Menus at root level

Right click the project list at the root level and it will allow you to add a new project and set up a project
Import and Export to your project list.

Additionally, you may also bring up an activities list for the selected department and change the project
groupings on the tree and set your display options.
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_

% Prajecks | ——

5 add New Project
Sanka

add Mew Phase

Import Projects
Export Projects

Delete Project
Showe Activities on this project

Switch bo Department Project Wiew
Praject Tree Display Options

Figure 29: Menu items at project level

At the project level, the advanced menu option provides you with the ability to Import or export, add a new
Phase, delete the selected project, and show activities for the selected project.

Importing your Project list from an existing Database

If you have an existing database of project information, you may use the Project Import feature to create
your initial Abacus Project List. Follow the given procedure to export project list from an existing database.

1. To access the import feature, left click on Projects and select Import Projects.

Add Mew Project
Import Projecks
Export Projecks

Delete Al Projects

Switch bo Departrent Project Yiew
Project Tree Display Options

Figure 30: Import Projects option

The Enter Data Import Job Details window appears.
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Enter Data Import Job Details |ﬁ|
Create Import Job
Q Create an impart jok to import Data
—Job details
Job Mame |E!uiu:k Import
Impart Data I Projects ;I
Import Source I File ;I
< Back Heut » Cancel

Figure 31: Enter Data Import Job Details window

2. Select the type of import you wish to perform from the Import Source drop-down list.

3. Select Next to proceed. The Config file source window appears.

Abacus Manager Version 3050
40 of 170



-
—

PRINT COST RECOVERY SYSTEM
Config file source g|
; Configure Import Job
@ Select the DetaSouce to configure an import jakb

File Informnation

Type |Excel -

Fath |C:'\D-:u:uments and SettingzhsabarnighD esktophContacts_07_18_2010_0 |:|

Drelirniter

Input File has

* Colurnn Header
" Mo Caolurnn Headsr

|dzer Authentication

< Back | Mewt » | Cahcel

Figure 32: Config file source window

4. Select the file type that you want to import from the Type drop-down list.

5. Click J (browse button) to locate the actual file.

6. You must specify if the file you are importing contains “Column Headers”. Column
headers are descriptive fields which normally occur as the first row of data to describe
the contents for each column below it.

7. Click Next to continue. The Preview Import Data window appears, which displays the
first few records from your file that allows you to select the worksheet containing the
actual project records you wish to import.
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Preview Import Data @

3 Preview Import Job

@ Previewy an import job ta viewy Data from Source
First Mame... | Middle Ma... | Last Mame... | Company ... | Title: 5 EMail :
Conkack kesk conkack comp stikants
himadri Majumdar ARC INDTA hirnadrir
Hiru 10 Majumder Hirnu10 Inc Lanmm
Hirul1 Majumder Hirnu10 Inc anmm
Himulz Maiumder Hirnu 10 Ing Lanmo
< >

Contactbddress | Contacthddress

Import O ptionz
™ Allow Duplicates {* Update Existing " Sync Data

< Back | Memt = | Canicel

Figure 33: Preview Import Data window

8. Select the specific import options from the Import Options section. The options are:

= Allow Duplicates: If you select this option, the data import will create a new
record for each record contained within the file or database. This option should
generally only be chosen when manually importing data into an empty table in
the Abacus database.

= Update Existing: If you select this option, the data will examine the primary key
for each imported record, and check to see if it already exists within the Abacus
database. If it does, the record will update the existing record. If it does not, it will
be considered a new entry into the database.

= Sync Data: If you select this option, the data will automatically synchronize with
the imported data.

9. Click Next to proceed. The Field Mappings window appears.
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Field Mappings E|
: Map Fields to Import Job
@ Map Fields of impoart job to setup scheduling jok

Click on Fitter button to apply fiter

Mate: Right Click on Filter Button to clean Filter

Destination Fields Source Fields Preview: Source Default Calumn Filte
Projectumber I_Nu:une_ - Column Filtg
Projectame _Mone_ = Column Filtg
ProjectDescription _Mone_ = Column Filtg
ProjectStatus Mane_ (=] MULL + | column Fitd
BillingCode _Mane_ - MULL ~ | column Fit
PriceCatalog _Mone_ = MULL + | Column Filtg
Client _Mane_ = MULL + | Column Fittg
Department _Mone_ = MULL * | Column Filtg
| | 3

Fow Filter Details Configure Row Filkers
- Mone -

< Back | Mext > | Cancel

Figure 34: Field Mappings window

10. The Abacus Database records three fields for each project.

=  Project Number
= Project Name
=  Project Description
= Project Status
= Billing Code
= Price Catalog
= Client
* Department

Using the header drop-down list, you can select the appropriate column from your input file that relates to

the required field. As you make your selection, the preview column will display the first record for the
chosen column. It allows you to verify that the correct data is being imported for that field or not.
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11. Click Next to continue. The Finish Job window appears as shown.

Finish Job 3

E Finish Import Job
@ Click Finigh to Save Import Job

Job Information

Mame: Import D ata: Import S ource:
2 Projects File
Source Information
Type: ColHeaders Drelimiter Import Option
Excel Yes Update Existing

Path
C:\Documents and Settingz\sabarnighDeskiophContacts_01_18 2010 03 06 15kl

Figld M apping |nformation

Source Drestination Filker e
Projectiumber Mong Mone
Projecthame Mone Mone
ProjectDescripbion . i None Mone
ProjectStatu Mone Mone
EilingCode Mone Mone -

Schedule Infarmation

MHat Scheduled

Advance Option

< Back | Finigh | Cancel

Figure 35: Finish Job window

12. The final screen allows you the ability to program certain defaults, which pertain to
records that may be blank within your import data. You may also set the default status for
all the imported projects to Active or inactive, which will enable you to hide new projects
from your users you have had an opportunity to review them.

Setting up an automated ProjectlistImport

If you keep a list of current projects elsewhere on your network, you may also set up a data link between

the Abacus manager and your project list. This will automatically insure that the project list in Abacus is
kept current.

An automated link may be created to synchronize with a database or a file.
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To create an automated import of project information, please see the chapter on Importing from a

database, later in this document.

Exporting Project List Information

From the advanced menu options, you may also choose to export your project information. To do this follow

the given procedure.

1. From the File menu, click Export = Projects. The Export Option Page window

appears.

I Create new data export job

@ Select column name
Export Fields
| Calurnn Name Select &l
¥ Project Number
¥ Project Name Clear Al
¥ Project Description
¥ Client Comparry Name Move Up ‘
v Default Biling Code =
¥ Active Status @iz i
V] PriceCatalog
[w| Default Phase Sart
¥ Department Colurn

Active Status 52

Order

47 -

Mate: Last eolumnz will be pricing columns:

< Back | Next > |

=

Cancel |

Figure 36: Export Option Page window

2. Select the check box adjacent to the fields that you want to export from the Export
Fields list box. You can click Select All to select all the fields within the Export Fields
list box. Click Clear All to deselect all the selected fields within the list box. You can click
Move Up or Move Down to change the field's place.

3. Select the column from the Column drop-down list that enables to make the exported
data fit within other reports without modifications.

4, Select the sort order from the Order drop-down list.
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5. Click Next to continue. The Export Settings Page window appears.
Export Settings Page &l
! Create new data export job
@ Enter File Information, Export Options and Fitters

Export File Information
File Path

|C:\F‘rogram Files\Abacus -
File Name |Abacus
User Authentication
Export Options

Colurnn D elimiter CSY Delimiter -

™ Replace Column Delimiter with spaces
Iv Column Headers

Fow Delimier Hew Line v
Column specifier e -

Filter

¥ Active Projects Orly

< Back | Mext > | Cancel |

Figure 37: Export Settings Page window

6. From the Export File Information section, enter the file path in the File Path box or click
__1 (browse button) to select the file path from the Browse for Folder dialog box.

7. Enter the file name in the File Name text box.

8.

To verify user authentication, click User Authentication. The User Authentication
dialog box appears. (Optional)

User Authentication le

Please enter the user credentials to access the netwark resouce

Domairt sermame

|F‘au| Feset

Pazsword

Test Connection | Save Cancel |

Figure 38: User Authentication dialog box
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9. Enter the valid user credentials in the Domain/Username and Password text boxes
respectively and click Save to save the settings.

10. From the Export Options section, select the column delimiter from the Column
Delimiter drop-down list. You may select CSV, Tab or Custom Delimiter format for
compatibility with a third party application. and set options for row and column settings.

11. Select Replace Column Delimiter with spaces check box to replace the column
delimiter with spaces.

12. Select Column Headers check box to set the field names into your file as the first row of
data.

13. Enter/select the row delimiter and column specifier in/ffrom the Row Delimiter and
Column Specifier box. Column Specifier will specify each column with the symbol
indicated in the box. E.g.(“)

14. Select the Active Projects Only check box to export the active projects only.

15. Click Next to continue. The Finish Job window appears.

Finish Job X

! Finizh Export Job
@ Click Finizh to Save Export Job

Job Information

Name: (K= Export Data:  Projects

File Information
Col Delimiter - C5% Dielimi Row Delimiter Mew Ling

Col Headers =

Path: D:ASabarni GuhahaRC_Task\Abacus
Sarting Order Sorting Column
Selected Fields
Source A

Schedule Information

Not Scheduled

Advance Option

< Back | Finish | Cancel

Figure 39: Finish Job window

16. Here, you can check the Job Information and File Information of the Project that you want
to export.
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17. Click Advanced Options to configure pre and post program execution. The Pre & Post
Program Execution dialog box appears as shown.

Configure Pre & Post Program Execution ﬁ]

[v PreJob Execution Option

(" External Program |D: YWSabarni Guha'ARC_Tazk\Abacuszscreenshabacus

™ Abacus Job | J

[v Post Job Execution Options

(+ Esternal Pragram |D:\Sabarni GuhatARC_Taskhbbacuzh3050%8bacusdd IZI

™ sbacus Job | J

Configure | Cancel |

Figure 40: Configure Pre & Post Program Execution dialog box

18. Select the required options.

= |f you want a particular job to be executed before other jobs, select the Pre Job
Execution Option check box and select the required option. The options are
External Program and Abacus Job. You can choose either of the two options
and select the external program path or the Abacus job as per your requirement.

= If you want a particular job to be executed before other jobs, select the Post Job
Execution Options check box and select the required option. The options are
External Program and Abacus Job. You can choose either of the two options
and select the external program path or the Abacus job as per your requirement.

19. Click Configure to configure the settings.
20. Click Finish in the Finish Job window.
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Chapter 4
Abacus Settings

Configuring Abacus Settings

The Abacus Settings window allows configuring several additional options in order to establish a very
comprehensive list of tracking parameters within the system. Not all of these options are required, but are
made available to you in the event that you can make use of them.

To access the “Settings” window, select the settings icon from the icon bar, or the settings icon from the
home page.

The Abacus Settings Window

The Settings window provides access to several areas of the application which will enable you to further
customize the tracking environment for your network. These include:

- illirng

=] codes
Sy Manual Activicy Types
- Tracking

app Extensions
Tracking Rules
ficcess Policy
Billing Popup
= IJsers & Groups
araups
sers
- Globals
Motes
B74 Phases
= Central

@ Data Sync
- Client Status

E! BillingPopup Status
= Manager Data
|'E—|| Departments

Figure 41: Settings window
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= Billing: You can add / assign Active Billing Codes and also add / modify Manual Activities
Types such as ‘Fax’ and ‘Phone’.

= Tracking: Enable application specific tracking. You can create / manage tracking rules and
actions, can select ‘Project or Departments’ for the Access Policy, and also customize Billing
Popup Settings.

= Users & Groups: Assign security permissions for all users on your network, individually or
by group. You can also import Users from Active Directory or by the domain.

= Global Settings: Define company’s standard notes and you can ‘Add / Delete’ Global
Phases to the Projects.

= Central Server: Define and verify the connection between your abacus database and the
Reprographers Central database.

= Client Status: Review the installation status of Client Billing Popup throughout your network.
= Manager Data: You can Add / Remove / Modify the Departments in the Projects.
Users
As you have seen in prior chapters, Abacus allows the system manager the ability to define how network
users can interact with the Abacus system. To set these permissions on a user by the user basis, the

users must first exist within the Abacus database.

Users may be added one at a time or can be directly imported. You can directly import users either by
‘Active Directory Import’ or by selecting ‘Import From Domain’ option.

Prerequisites: Prior to creating users, you may first wish to define groups. If groups have not yet been
defined, please refer to that section of this manual first, before you enter a user in the system.

Importing Users from Your Network

Prior to bulk importing users, it is a good idea to pre-define how the system will generate PIN numbers for
the users.
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Print Users
Active Directory Import || Irnport From Domain
Usger Mame Sroup
Admin Admin
Masteradmin Master Admin
Total#: 2
| Add Print User | | Remove | | TodiFy | | Manage PINs

Auta Senerate PIN Numbers while Importing Users

Generate PIN always Numeric Value
Mazxirnum Characters for Auto Generate PIN Maxirnurm Allowed: 5
Figure 42: Print Users section
At the bottom of the User editor window, you will see options for generating user PIN numbers. If you wish

to have Abacus automatically generate user PIN'’s, then check the box labeled “Auto Generate PIN
Numbers while Importing Users”.

You may decide whether or not the PIN’s should be all numeric or mixed characters. Set the Maximum
characters for PIN. The maximum characters allowed are 5.

Importing users from Active Directory

If you are running Active Directory, click Active Directory from the Print Users screen,

Host Information ﬁl

Enter host connection information

Host. |FDC-O1

User; |ﬁ1‘-.dministrator

HREREHRARERRHRL

Password:

akK | Cahcel

Figure 43: Host Information dialog box
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21. Enter the name of your Active Directory server

22. Enter a valid user name and password for the domain.

23. Click OK to launch the import process.

Importing Users from the Domain

If you are not running Active Directory, you may import users from your Domain.
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Step | : Select a Domain

MPTDCTAMDIA |
—Stepll : Select Servers

Mame In Falder ~
ARCINCEBEUPSYRZ1 :MPTDC1-INDIA

ARCINDCTO95 MPTRC1-IMDIA

ARCIMDDY MPTRC1-IMDIA

ARCIMNDNSWOSE-1 (MPTDCI-INDIA

ARCINDSERVER LY (MPTDC1-INDIA

ARCINDTESSYR19 MPTDCI-INDIA

ARCINDTS1E1 MPTDC1-INDIA

ARCIMNDTSSWRI4  IMPTDC1-IMNDIA

INDAPPSERVERLZ MPTDC1-IMNDIA

INDTACCTO33-1 MPTLC1-INDIA

THDTARMMTAR-1 MPTRC 1 -TRNTA ‘_’
Step lll: Select Uzers

Mame Comment Flags Ful
[] SUPPCRT_38... iThis is a vendor's account For the Help, ., (66051 M=
TWaM_ARCIN, .. Builk-in account For Inkernet Informati.., 66081 Lau
IUSR._ARCIM... iBuilt-in account For anonwmous access. .. (66031 Inke
Guest Built-in account For guest access to th,., (66083

[] ASPMET Account used For Funning the ASPGME,., (GE0S1 ASF
[ &dministrator  iBuilt-in account for administering the c,., (66049

£ >
Select Al Impart Close

Figure 44: Import Users From Domain window

Select the Import from Domain option and then choose the Domain, the Server, and the Users that you
wish to import. Click Import to launch the import process.
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Users can be added to the system individually. To add a new user, click Add Print User from the Print

Users screen.

Add New User g|
User Information
First Name: User Name
Last Name Pagzsword
Location Key Re-enter Password
FIN Management
Department ‘ Mone j
PIN Info
I™ Auto Generate PIN
Motify Emai r
Max. Characters for
Select Group Permissions
Admin Permissions |
tdaster Admin
Frintlsers
™ Customize Permissions
Count for Quota Tracking Access Policy | [T -

Figure 45: Add New User dialog box

For each user, you may define their user name and password, which will allow them to access to the
manager. You can also provide Location Key and Department details where the user belongs to.

The PIN can be manually assigned, or set to Auto-Generate by the system when the user is added. You
may determine whether or not the Auto generated PIN is all numeric or mixed characters.

You may then indicate which group the user should be associated with. You may select the groups from the
pre-defined groups in the system, or you can create a new one from the Groups Editor.
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Add New Group g|
Group Mame
|F'DEZ
Description
|F'rint Users

Azzign Group Permissions

Rales ”~
[ ] allows Login ko Manager

I:| Wiew Devices, Media, PaperSizes

[] Manage Devices, Media, Papersize
[] Wiew Pricing

"] Caonfigure Pricing

[ Wiews Projects & Clients

[] Manage Projects & Clients

[] Wiew Activities

[] Manage Activities

[] Wiew Reparts

[ ] Manage Reports

[] View Groups/Users

[] Manage Groups/Users
[] Configure Rules

[ patshase Administratinn

Count for Quota Tracking |10

Aocess Policy

Add Cancel |

Figure 46: Add New Group dialog box
Generally, for easier administration, you might assign permissions at the group level. However, in some
cases you may choose to override the group permissions, and assign them at the user level. If you wish to
do this, you may enable or disable permissions by selecting check boxes in the permissions list.
Max Job Count can be set at the user level to indicate the maximum number of print requests that the user
may snooze through without entering billing information. This Max Job count may also be set at the group
level. User values will supersede group values in that event.
Click Add to save the changes for your new user.
Defining Groups

Administration of security for Abacus users is greatly simplified by defining security groups.

As new employees are added to the system, they can be quickly assigned to an existing group, and will
automatically inherit the permissions and rules that have been defined for others.
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To create a new group, expand the Users and Groups item on the settings list, and then select the Groups
icon.

—-E)% Users & Groups

@ GFoups
~[E% Users

You may also add a new group, modify the group, and remove an existing group from the Users & Groups
option in the left hand panel.

User Groups

Group Marme Dezcription
Admin Admin
Master Adrnin Master Adrmin

PCC Print Uzears

Printl=sars

Printl=sars

Add Group | | Remove | | Modify

Figure 47: User Groups screen

In the Groups Editor, click Add Group to add a new group. The Add New Group window appears where
you will be prompted to enter a name and description for the group.
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Lo Mew

Group Mame
|Hemﬂ

Description

|Fietai| Construction Group

Azzign Group Pemizsions

Roles

|

[] Allow Login ko Manager

[] Wiew Devices, Media, PaperSizes
Manage Devices, Media, Paperdize
[ Wieww Pricing

[] Canfigure Pricing

Yiew Projects & Clients

[[] Manage Projects & Clients

Yiews Activities

Manage Activities

[ Wiew Reports

[[] Manage Reports

Yiew Groups/Users

[[] Manage Groups/Users

[] Configure Rules

[T natahase Administeatinn
4 |

Court for Quata Tracking |10

Access Policy 1 Mane j

|

|

Add | ey |

Figure 48: Add New Group window

You may then select the individual permissions that you would like to have associated with the users of that
group.

Group permissions deal with the ability to view, configure or manage information stored in the Abacus
database. Once users have been assigned to a group, you may refer to the group when setting up rules to
determine the print workflow for your users.

In general, you would like to grant view permissions for the typical user and manage permissions to
Administrators.
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You may also set a Max Job Count value for users of this group. This will allow them to snooze through a
set number of print requests before they are forced to enter billing information. This value may be set at the
user level as well, and if so, the user value will override the group value.

Once you have completed setting permissions from the group, you may click Add to save the settings to
your database.

Over time, you may wish to change one or more permissions that you have set. For this, click Modify in the
groups Editor. You will then be allowed to change permissions, which will affect all users of the Group.

Permissions set at the user level override permissions set at the group level, allowing you the to customize
permissions for an individual without impacting a previously configured group.

Defining Billing Options

Creating Billing Codes

Typically, print costs are either considered to be reimbursable or non-reimbursable. When a user on your
network generates a print request, they may also specify a hilling code to determine how the print will be
used, and whether or not it is to be considered a client expense or an overhead expense. You may create
and customize these codes to fit your needs.

To open the Billing Code editor, click Settings from the main menu or select Settings icon from the Icon
Bar.

Manage Activities

=
) =

Activity |

Figure 49: Settings

The Settings Window is divided into two frames, the “Settings Tree” on the left hand side, and the
“Settings Editor” on the right hand side.

To create a new Billing code, expand the item labeled “Billing” on the tree by clicking the plus sign next to
the name. You will then see two billing options, “Codes” and “Manual Activity Types”.
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When you click on “Codes” the Settings Editor will update to display the Billing Codes Editor.

Active Billing Codes

Code Descrip... | Farnatks Iz Billable
Man-Reimburs... Mon-Reimbursable Ma
Reimbursable Feimbursable fes

Add EBilling Code || Remove || Muodify

Figure 50: Billing Codes Editor Screen

To create a new code, click Add Billing Code. The Add New Billing Code dialog box appears.

Biling Code M ame

iln Houze

Remarks

iln-HDuse
[+ |z Billable [tem

Add Cancel

Figure 51: Add New Billing Code dialog box

You need to enter the billing code name and remarks associated with the billing code in the Billing Code
Name and Remarks text boxes respectively. Optionally, you may select whether or not this type of print
activity is ‘Billable Iltem’. Select the Is Billable Item check box to mark it as a billable item.

Click Add to add the information to the database. The new code will be displayed in the billing code list,
which you can modify or delete when no longer required.
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IC' \ Once hilling codes have been defined, you may enable or disable them for any particular project.
/'

Manual Activities

There may be one or more items such as scanning or manual copying which cannot be automatically
tracked on your network. Abacus provides you with the ability to define and enter these items into the
database, so that you may create comprehensive reports for your clients.

To define a new Manual Activity type, click Manual Activity Types from the billing section of the Settings
window in the left hand panel.

Manual Activity Types
Do not use 'Print’, 'Copy', 'Scan’, 'RIP' as
Manual Activity Types

Tupe Description
Fax Fax Job
Phone Fhone
| Add Manual Activity Type | | Remaove | | Madify

Figure 52: Manual Activity Types Editor Screen

To define a new activity type, click Add Manual Activity Type. The Add Billing Code dialog box appears.
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Billing Code Mame

||nHu:uuse

Remarksz

||n-H ouse

Add Cancel

Enter the type name, and the description associated with the type in the Billing Code Name and Remarks
text boxes respectively. Click Add to add the new type, which will be stored in the database, and displayed
in the types listing.

Once defined, a manual type can be edited or removed at a later date as per requirement.

Global Attributes

Creating Global Notes

Pre-defined Notes can be created to establish a print reason on the Abacus Billing Pop-Up. You may
create a list of notes and use them on the system, as a time savings tool, and also to provide for consistent
terminology in your reports.

To create a new Global Note click “Tools Settings” from the main menu, and expand the item labeled
“Globals” from the settings list. You may then click on the item labeled “Notes” to display the Notes Editor.

In the Notes Editor, click Add Global Note. The Add/Edit Notes dialog box appears.

Add/Edit Notes X

E nter Global Motes

|D ezigh A eview

v Set as default

Add Cancel

Figure 53: Add/Edit Notes dialog box

Enter a new note in the Enter Global Notes text box. You may select the Set as default check box to set
the global note as a default one. Click Add to update this information in your Database. You may edit or
delete a Global Note any time as per your requirement.
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Global Notes

[ Add Global Note [ Remove [ Modify |

Figure 54: Global Note added as default

When a user submits a print request, the billing pop-up may allow them to enter a note to describe the
reason for the print. They may choose from pre-defined Global notes, or enter a different reason in the
notes area.

Abacus Billing Entry

Unbilled Jobs
lolta M s

- Phase List Billing Codos
=] Jom =]

Commants

ERL e eieas]

Figure 55: Abacus Billing Entry screen
Creating Project Phases

The Abacus system stores a list of standard project phases which you can assign on a project by project
basis. To create a standard phase, select “Tools 2Settings” from the main menu, and expand the item
named “Globals”.

Under the “Globals” branch of the settings tree, you will find two options, “Notes” and “Phases”. When you
click Phases, the Settings Editor will refresh to display the Global Phases editor.
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Global Phases

Phase Name | Phase Number [ activastatus |

Construcion oo1 Active

Add Global Phase | | Remove

Project Options

[7 wWhen new Project added, =dd Global phazes to project sutomatically
™ When new Global phase added, add new Global phase to all projects
When Global phase is deleted, delete Global phase from all projects

Save Project Options

Figure 56: Global Phases Editor screen

To create a new Phase, click Add Global Phase. The Add Phase dialog box appears.

Add Phase

Phaze Mumber

=

|nnz

Phaze name

!D 2zigh

v Active

Add Cancel

Figure 57: Add Phase dialog box

Enter the phase number and the phase name in the Phase Number and the Phase Name text boxes

respectively. Select the Active check box to mark the phase as an active one.

Click Add to add the new phase information, which will be stored into the Abacus database and will be

displayed in the Phases list, which you can modify or remove as per requirement.
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Global Phases

| Phaze Hame | Phaze Number ActiveStatus
ruction 0ol Active

Add Global Phase | Remove

Project Options

When new Project added, add Global phases to project automatically

A0

When new Global phase added, add new Global phase to all projects

™ When Globzl phase is deleted, delete Global phase from all projects

| Save Project Options |

Figure 58: New Phase added

You may also set project option that will dictate how the Standard Phases are to be
added to projects. You may choose to have them added to all new projects, or to all
projects. You may also set an option that will delete a standard phase from all projects
if it is ever removed from the global phase list.

Project Options

When new Project added, add Global phases to project automatically

When new Global phase added, add new Global phase to all projects

W when Global phase iz deleted, delete Global phase from zll projects

| Save Project Options |

Figure 59: Project Options

Please make sure to click Save Project Options after you have made changes to the Standard Phase list.
This will ensure that all of your changes are properly recorded to the database.

Custom project phases can also be created from within the Project Editor, listed earlier in this guide.
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Tracking

Application Extensions

With Abacus, you may impose rules for printing based upon a number of different factors. One of these
factors may be the types of applications that you wish to track. For example, perhaps you only want to
track CAD output to a plotter, and do not wish to track color renderings being produced by your marketing
department. If we tell the database to track print requests from .DWG files but not from .PSD files, we can
accomplish this task.

To set up important applications in the database, click the “App Extensions” item from the “Tracking”
section of the settings tree. The Applications Extension screen is displayed in the right hand panel.

Application Extensions

App Mare | Extenszions
Microsoft Ward dac
Auto CAD dwg,duf
Add Application Extension| | Remove | | Modify

Figure 60: Application Extensions screen

To add application extension, click Add Application Extension. The Add New Application Extension
dialog box appears.

?‘: o e s Sy L b T U ig‘
e

Application
‘Photoshup

Specify multiple extensions seperated by commas [,

Extenszion

‘md, if

Add Cancel

Enter the application name and the file formats associated with that application and separated by commas
in the Application and Extension text boxes respectively.
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Once defined, click Add and the application gets added in the Applications Extension list, which can be
modified or removed at a later time based on requirement.

Application Extensions

App Hame l Extenzions |
Microsoft Ward doc

Auto CAD dwa,dwf

Add Application Extensionl | Remove | | Modify |

Figure 61: Application added
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Tracking Rules

You may not want to impose the same set of print tracking rules on all the users in your network. For
example, you may not wish to track prints that are run in your accounting department. The Abacus system
allows you to define rules for individuals, applications, and printers on your system so that you can tailor
the system to suit your particular needs.

Rules are actions which can be enabled or disabled based upon the User, the application or the printer
that is being accessed.

Prerequisites: Several items need to be defined before you can properly set up tracking rules in Abacus.
These include:

= Users

= Groups

= Application Extensions

= Devices

If these have not yet been defined, please refer to those sections of this manual first, before you enter a
tracking rule in the system.

To create a rule, click “Settings” from the home page or from Icon Bar. Then select “Tracking = Tracking
Rules” from the settings tree. From the Rules window, you may then click Add New Rule.

If this rule affects some users, but not all, then first select the group that contains the user, and then select
the user(s) that you want to be governed by the rule. After that, click OK.

If the rule applied to print jobs only that are requested from certain applications, you may then select the for
the applications(s) check box. Then select from a list of available application extensions to bind to this
rule. Click OK.

The next page covers devices. You may set rules to work with some printers. Select the printers on which
you wish to apply the rule or select the Any Device check box and then click OK.

You can also select Rule Condition Type as ‘Activity Type’ like Copy, Fax, Phone, RIP, Print, Scan, etc.
Just select the items from the master list and then click OK.

If you wish to apply the rule to the print jobs only that are related to the sheet size, you may then select if
sheet size is not equal to, if sheet size equal to, if sheet size less than, etc. check boxes. Then select
the size from a list of available sheet sizes to bind to this rule and click OK.

You can also apply the Rule Condition Types by selecting if user name starts with, if machine name
equals to, if device name not equals to, etc. check boxes in Tracking Rule Editor to tailor the system to
suit your particular needs.
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Tracking Rules Editor
Create [ Manage tracking rules and sctions

Rule Mame: |Accounting Description : |if user use Microsoft Application Prioritp: |1

Rule Condition Types Rule Condition Yalues

Rule -~

HACTION"

if doc name equals ko "
choose-action :

if doc name not equals ko

if doc name contains

if doc name starts with

if doc name ends with

For the docs with extnis)

Faor the applicationis)

if users are equals to

if users are not equals ko

if user name contains

if user name starts with

if user name ends with

if machine name equals to

if machine name is not equals ko
if device name equals ko

if dewvice name not equals ko

if no.of sheets equals to

if no.of sheets less than

if no.of sheets greater than

For sheet's sqft equals ko

if sheet sgft is less than

if sheek sqft is greater than -
if activity bype equals ko

if activity bype is nok equals to
if sheet size equals ko

if sheet size is nok equals to “

ok Cancel

Figure 62: Tracking Rules Editor dialog box
The final page allows you to set the type of tracking that you wish to impose with this new rule.

= Silent - Tracks the print job, but does not invoke the billing pop-up.

= Quota - Allows the user to send several print requests before being nagged by the Billing
Popup. You will be shown a “Max Quota Prints” input box to set the number of prints the user
may send.

= Regular - This will trigger the pop-up and request the billing information from the user each
time they send a print job.

= No Tracking - This will bypass the collection of billing data for this type of print request.

Rule Condition  alues

ACTION
choose-action ©

Select Action

Action

SILENT

[ quaTa

v| REGULAR

| NO TRACKING

]

<]

Figure 63: Select Action
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Once you have selected the tracking type, click Next where you will be asked to enter a name for this new
rule. Click Finish when done to save the rule.

Tracking Rules

Fule Mame Cescription Pricrity
Quotald If Uzser [Masterddrin'l Print if the JobMame 1
Accounting If Uzer [any user] Prints if the JobMame 1

Add Mew Rule || Femaove \;

Figure 64: Tracking Rules screen

If changes are required, rules may be modified or deleted at any later date.

The rules feature provides a great deal of flexibility in how you capture billing information from the system.
In some cases Tracking Rules may impact a single print request.

Defining the Access Policy

You can allow users to access specific Projects according to their Client access. You can create new
Access Palicies either on Project basis or related to the Departments, they belong to.

Access Policies can be set at the Group level or at the User level. By Creating Access Policies a user can
login into any machine in the network and will have access to only those Projects whom he is assigned to.

Example: In one company there are 50 users and they are divided into 3 groups: G1 (20 users), G2 (20
users), and G3 (10 Users). Similarly there are 3 Access Policies: AP1 (10 projects), AP2 (10 projects), and
AP3 (10 projects). We can apply a rule so that G1 has AP1, G2 has AP2, and G3 has AP3. Hence we can
restrict the groups to view all the projects. They can have access only on the assigned projects.
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Figure 65: Creating Access Policy using Projects
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Figure 66: Creating Access Policy using Departments
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Access Policies

S.Mo Access Policy Mame
1 Guest Access
2

Adrnin Access

Default Access Policy for new users: E-q-dl'l'lil'l Access _‘ﬂ

---Mone---
Guest dccess

Creake Mew Policy | I Remoye | Modify I

Figure 67: Access Policies

Once the Access policies are defined, you can add Users to the Group and grant ‘Customized
Permissions’, which will be applicable to all the Users in that particular Group.

Modify User

(]

User Information

First Narne User Mame

[FHewton

|Fed

Last Mame Faszsword

[Meviton

Location Key

Reenter Password
[KEv-1

PIN Managsment

Diepartment | Desian Division -1
PIN Info
W futo Generate PIN
v
Notity Email Al Humbers
test@mirrarplus. com

tax. Characters for -

Select Group FPermigsions

Admin
b aster Admin

Permissions

b3

| Manage Devices, Media, ...

] igws Pricing
s Configure Pricing

¥ Customize Permissions

Count for Qusta Trackig [0 Access Poicy  [EE N R ~ |

Figure 68: Adding User to the Group
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Defining the Billing Popup settings
As the users send print requests, the Abacus Billing Popup pops up where you need to enter project name
and billing information related to their print job. You may configure the client to pop-up with every print
request, or enable it to sit quietly in the background until a user’s quota has been met.
To set up the Pop-Up options, click ‘Settings’ from the main menu, and then expand the item labeled

“Tracking” on the settings list. When you then click “Billing Popup” the right hand screen displays the Pop-
Up Settings editor.

Billing Popup Settings

Batch Printing Maximum Count

Batch Printing Timeout {seconds)

| Ld || =
L Y | s I e}

Maximum Snooze Time (seconds). Nete:- snoeze time of (0) hides the snecze butten at
the billing pepup

Maximum Times user can click snocoze button between activity record( use 0 for

I

unlimited
Billing Popup Cache Refresh Interval (seconds)

Figure 69: Billing Popup Settings Editor screen

Batch Printing Maximum Count: If you want to allow the specific users to make several prints, they need
to define the billing information. You may establish a maximum number in the Batch Printing Maximum
Count text box. In the example above, users will be allowed to send up to 10 print requests before the
Abacus Billing Popup will interrupt them for billing information.

Batch Printing Timeout (seconds): You can also set a timeout value to work with batch printing. This will
be useful if the user is printing several sheets one at a time, and wants to consider it as a batch print job. In
the example above, the value of 300 seconds will allow the user 5 minutes between prints in order to load

and set up a complex print request.

Maximum Snooze Time (seconds): When the Abacus Billing Popup appears, it may provide the user
with a “Snooze Button”. Setting a snooze time, allows the user to delay in entering billing information for
their printing until the snooze time elapses. You may disable snoozing altogether, by setting this value to
“0". This will hide the snooze button from the user.

Maximum Times User can click Snooze button between Activity Record: Some users, will of course,
get used to clicking the snooze button every time if it is offered and will quickly adapt the habit of putting off
their billing assignments indefinitely. For this reason, you will probably want to impose a maximum number
of times that the snooze button may be used.
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Billing Popup cache refresh interval: The Billing Popup does not connect directly with the Abacus
Database. Therefore, it needs to communicate with the Abacus Server to get the updates for the project list
and other data. You can set an interval in ‘Seconds’, which will cause all Pop-ups to check in with the
Communication Server which allows downloading the latest information.

After you have finished entering the values for your Popup settings, click Save to record the changes to
your database.

Billing Popup Display Settings

Field Display Name Required Disable Mo Edit
Froject: | Project List | v ||

Phaze: |Phase List | v []

Billing Code:  |Biling Codes | [ v

Media: |F'a|:|er Type | [ v

Motes: | Comments | | | IF |
UserlD: |I_I5er |

PWD/PIN: | PIN |

Mote: use the custom field manager to set display attributes for any custom fields
Figure 70:

Pop-Up display settings allow you to configure the required options that should be made available or
unavailable to the user before the user is allowed to print.

For each display option, you may enter a name for the option and select whether it should be a required
field or not and whether the field can be modified by the user.

Project - This allows the user to choose the Project that the print job will bill to. If enabled, a drop-down box
will allow the user to select the projects that are previously defined in the Abacus Manager.

Phase — Many users will wish to track their expenses through each phase of a project. If phase is enabled,
the user can select phase from a list of previously defined phases for the selected project.

Billing Code — Typically set to either reimbursable or non reimbursable, if enabled, the user may select
from a list of available choices.

Media — For each printer, Abacus maintains a list of paper types which should be present on a particular
machine. If enabled, the user may select from available choices, or select the default.
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\ Frequently, it may be required that the user enters some notes describing the reason for the print. If
- enabled, the user may select from the pre-defined notes, or may enter a new reason for the print request.

General
[ Dizable uzer editing of Abacus Server settings in billing popup
[ Disable user editing of Activity Display option
[ Dizzble uzer editing of Abacus billing popup position
[ Disable auto select last project option
™ pon't Show Balleon Tips
[ Dizable Quick Select Buttons

New Project Entries
[ Allow new Project entry by users

C Restrict to numeric characters when entering new project numbers

User Activity Display
8 Display Activity for current logged on user
f* Display Activity for All users

™ Nene { Use the option s=t by user )
Project List Display
Show Project List as Name
Show Project List as Number

~
~

" Show Praoject List 2= Name [ Number }
" Show Project List as Number{ Name )
s

None [ Use the option set by user )
Phase List Display

Show Phase List a5 Name

Show Phase List 25 Number

Show Phase List as Name ( Number )

O 0 G Ry

Show Phase List =25 Number [ Name )

D

None [ Use the option set by user )

| Save |

Figure 71: Additional Pop-up Options
Additional options can be selected to provide user access to customizable Pop-Up features, or to provide
access to print activity lists and user activity lists. You can also customize the project list display and phase
list display on the billing pop-up.

Below you can see the figure depicting the Abacus Billing Popup.
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Abacus Billing Entry

B Abacus.

Unbilled Jobs
Jab Hamea

Figure 72: Abacus Billing Entry

= Project List - You can select the Project that should be billed for the Print Job. Example:
‘Test Project2’. The Project drop-down contains the Project name, the Project number, or
both.

= Phase List - You can select the Phase the print should be billed to. Example: ‘Construction’.

= Billing Codes - You can change the billing codes from ‘Reimbursable’ to ‘Non
Reimbursable’, if required.

= Paper Type - You can select the Paper Type as ‘Bond’, ‘Letter’, etc. The list of media has
been pre-configured by the Administrator in the Abacus Manager.

= Snooze - Click snooze if you prefer billing later.

= Unbilled Jobs Section - The top of the Abacus Billing Popup displays the name of the
document which is printed. ‘Device Name’ gives the information about the printer you send
the job to. ‘Originals / Copies’ provide the information on how many pages are in the original
document and how many copies of it are requested.

= Quick Select Button - You have 5 Quick Selecting Buttons above the Project field. You can
start complete answers in each of these billing fields into the buttons for your most common
billing selections. Just fill as much information as you can into the fields and then press the
button you wish to retrieve the data.

= Comments - The Comment field can help quickly identify print jobs later on. Selecting a pre-
defined comment makes it clear why the print job was run, eliminating confusion and better
understand cost.

= Enable Batch Printing mode - You use Abacus Batch Printing Function when you have a
bunch of printing jobs that you know would be billed to the same project. E.g. If you printed a
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Project and you know that your next 12 printing jobs will be billed under the same Project.
You should click ‘Enable Batch Printing Mode’ and enter 12 under the box. Abacus will
display the message in the System Tray rather than presenting the whole billing Popup.

= Project Favorites - We can add some selected projects to favorites. Display settings for
projects and phases are given here.

= Popup Preferences - Position of the Popup screen displayed is set here. The columns to be
displayed are also set here.

= Server Settings - The details of the Billing Popup server are shown here.

= General Preferences - The task bar balloon tips can be enabled /disabled here.

Abacus Billing Entry = 0 2 0

B Abacus

i\ Project Favarites

£ » Popup Preferences

£ W Server Settings

i W General Preferences

Figure 73: Abacus Billing Entry

Client Status

To tack properly every print request on your network, you need to ensure that the Abacus Billing Popup
application is installed on every workstation in your network.

The Billing Pop-up communicates with other modules of the Abacus system in order to pass along the print
information to the database, as well as to pull project information from the database to present to the user.
We can therefore communicate with the individual instances of the billing pop-up to determine where it is
installed and at what version it is running.
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- Client Status
g !E’ EilingPopup Status

Figure 74: Settings

Billing Pop-Up Status
The Billing Pop-Up Status window provides a view of installed pop-up clients on your network. You will

want to review this listing periodically to insure that each workstation on your network is running the billing
pop-up, and that it is a current version of the product for compatibility with the other Abacus components.

Print Users

| Refresh | | Export |
Status|Machine [Port }ﬂidress h';gEEd B I[‘)ZStEREfrESh Yersion |Remarks Delete
Aryabhsta 9090/10.0.0.169 fsl'ersr}aEIr‘-iar 1150:2288:2%9 o sn.:i:ioczosta:tinad(oawjilipzzroogfSSiDnal Del
Totalé#: 1

Figure 75: Billing Pop up Status sceen

Manager Data

Departments

B Manager Data

Figure 76: Settings

You may wish to generate billing reports broken down by Department. In order to do this, you first need to
define departments in the Abacus database. From the Settings tree, expand the link named “Manager
Data” then click “Departments” to view the Departments editor.
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Departments
Marme I Ce=zcription I
Construction Project 1
Design Project 2

Totalz: 2

1 | Remove | | Modify

Figure 77: Departments Editor screen

To add a new Department, click Add Department. The Add New Department dialog box appears.

Add New Department E|

M ame

lD &3igh

D'escription
lﬁuﬁd?

Add Cance

Figure 78: Add New Department dialog box

Enter the name of the department and the description related to the department in the Name and
Description text boxes respectively. Then click Add. The new department gets added under the
Departments list.

You can madify or remove the Departments at any later date as per requirement.
Central Data Sync
The Central Data Sync window is set up by your Reprographics Provider, and is used to automatically

transfer activity information back to their offices for reporting. This area also contains the registration details
for your Abacus License. There are no user editable fields in this section.
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Chapter 5
Abacus Reports

The Abacus system ships with several pre-defined reports built-in. These reports can be customized by
date range, Client, Project, Printer or Media and can be sorted by several criteria.

Accessing Reports Screen
Follow the given procedure to access the reports screen.

Click View =>Windows =>Reports from the main menu or click Repais from the icon bar of the Abacus

Home Page. The Reports screen appears. The Reports screen is divided into two frames: The left hand
frame consists of list of Reports and the right hand frame consists of Report Options.

xc Abacus Manager

P Fle Wiew Took Help X
Hew P Delete | &2 Refrash Bsave | cal
Hame [ &5 reports f m
5 Dust of Activities List Of Activities User Summary
This repart generates a list of all activities..., This report gensrates summary of soft and cost for each
User Summary e,

Activity MediaSummaryReport

= DeviceSummaryReport

L ActivitySummaryRepart

Projects JobMediaDetails

A= IMyFarmatRepart

Eg ProfitSummaryRepart

Settings PlotUsageReport — -

Custom Reports Media Summary E Device Summary E
% Profiles This report generates surnmary of all media used.... -l This report generates soft summary of all devices... dl
Reparts || * ireb Reports V/ﬁ J
o
Summary
! Activity Summary E Job Wedia

w This report generates summary of all activities per (s report qenerates media used per praject, .
Devices project... V/\

Media

.

%

Paper Sizes = =
PlotUsage | | Profit Summary |
@ This report generates a usage report..., This report generates a summary of sgft and cost for each
Pricing . project.... [
Clients
| o
= | B
Report

Figure 79: Reports screen
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The Abacus system ships with several pre-defined reports built-in. These reports can be customized by
date range, Client, Project, Printer or Media and can be sorted by several criteria.

Creating Report
Follow the given procedure to create a report.

1. Select a suitable report title from the report list. The form for the specific report appears in
the right hand frame.

Generate Report Clear Filter Szve [ Manage Filters
Report Dates Start Date
End Date
Job Status Select Job Status filter: none

Clients Select Clients filter: none
Projects Select Projects filter: nens
Devices Select Devices filter: none
Media Select Media filter: none
Departments Select Departments filter: none
Billingcodes Select Bilingcodes filter: none

Users Select Users filter: none

PrintFrom Select PrintFrom filter: none

Location Key Select Location Key filter: nene

Provider Key Select Provider Key filter: none

Figure 80: Form

2. Set the parameters for the report from the options. Any field which is not specified, will
default to “All".

3. Click Generate Report after setting the parameters.

RS L L} SR-N YT [ -

-+ Maonday, November 2, 2009
Abacus

Job Detall Report

Dats Bange: AN

0T B MW Mot onsn Warks

Hand

Reimbursable

10IFRIINNG 1 ATTRY sudhakar  OOZ.AMW Motoron Warke Tost Page Fannis Mas 100
Tels) For Raimburs 160
TOTAL FOR:  Gand o0
Unas signed
Unassigned
1007612008 1 LTTPY sudhakar  OOZ-BMW Motoren Wesks Tost Page Fannia Mas 1.00

Tetal For 1.00

TOTAL FOK: sl 100

TOTAL FOR PROJECT: 00 2-BMV Matoren Wesks 200

Figure 81: Job Detail Report
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Most Abacus Report contains a project list in the left hand frame, and report details in
the right hand frame. If you wish to quickly review report details for a given project,
you may select it from the project list. This will then regenerate the report and bring
you to the first page which contains information for the specified project.

The reports toolbar enables you to navigate, zoom, print, or export the report.

P S

1 i x £ @ [loox ~

Figure 82: Report Toolbar

Different Options from Report Toolbar

Options Actions
- Clicking the Print icon from the Toolbar will launch your print window.
= Print icon Abacus Reports can be printed to any Windows based Printer and will

get tracked.

B

Exporticon

Clicking the icon allows you to export report data to several standard file
formats or directly to an ODBC compliant database.

k7

Refresh icon

Clicking this icon enables you to regenerate or refresh the report data.

Zoom View

You may set the zoom View tool to any percentage or fit all or Fit Width
in order to get a clear/close view of the report.

111

Navigate Pages

You may use < or > to navigate forward or
backward a page at a time, or you can use |< or >|
tools to Navigate to the first or last page in the
report. Enter a page number in the text box to view
the specific page.
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Custom Reports

Abacus ships with a number of pre-defined reports available for immediate use. However, you may need
custom report which will display data according to your requirement. In that case, discuss your
requirements with your reprographics provider who will create a customized report for you. They will
provide you with the new report file, which can then be added to the system.

Web Reports

You can get Reports in HTML format directly from the web server.

Follow the given procedure to generate a web report.

1. Expand the Web Report from the Reports section.

= _j{‘ Reports

&y List of Activities
User Summary
MediaSummaryReport
DevicesummaryReport
Activity SummaryReport
JobMediaDetails
MYFormatReport
ProfitSummaryRepart

EEEEEEEEe

[m]
=g 3
o
oy
&
&
a
3
5
F:3
&
L&}

ustom Reporks

L

Activities_List_Project
Activity SummaryReport
ePremierictivities
Invoices w stabement
PrintActivityReport
Project_Media_BillCode_Originals _Copig
Project_Media_Comments_Detail_Pagel
Project_Phase_Media_InvoiceMumber_
%3 Project_Phase_Media_Invoicellumber_

PEEEPEEET

Figure 83: Reports section

2. Select the report from the list.

anacate Baz
Ragort Dates
b St
&y et et dhents
By Proct_pecka BiCnde_ Origas Cope
£y Prowct_Meda Comments Detal Faged Prejects.
iy Proet Phase Joed frvocstrsber
& Preimct_Phue Meda_invoicelsber | Duvicas
Mecka
Departments
Billpodes
=
Erntime St PretFrr o
Rocaion Koy e Lot

Figure 84: Form
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4, Click Generate Report. The report in HTML format is generated.

ZLZ00% 11:08 AN P1

10/2L2009 11:09 AN PL
IVZLZ00% 11:43 AN PL

VL2009 11:44 AM PL

0/ZL005 110 PM PL

10252009 11009 &M PL -

WELE00F 108 PM PL -

ate Project Humber - Hame
+ Test Frajectl

Test Frajectl

« Tast Projectl
= Tt Frajectl

- Tast Frojectl

Test Progectl

« Test Frajeckl

Activity List

Elient Hame

Dewice Mame
“Whary abhata\Canon
Bubble-let G- 10s

“hary abbata®Canon
Bubble-ot 8310«

Whary abbsta®Canss
Bubble-Jet Bl-10s

“Whary abhata'Canan
Bubble-let Bl-10e

Whary sbbata® Canan
Biiblbils-Jut B)-10¢

LTTR1

LTTRL

User
sudhakoar

sudhaicar
sudhakar
sudhaiiar
sudhsicar

sudhaicar
sydhakar

11/2/2009

Date Range: 11,/2/2009 to 11/2/2009
Sqit. Cost

100 0,00

100 0.00

1.00 .00

100 o.00

1.00 2.0

1.00 2.00

10 o.0o

Figure 85: Report generated from the Server in HTML format
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Chapter 6
Abacus Summary

The summary screen gives a detail report of the activities performed.

Accessing Summary Screen

Follow the given procedure to access the summary screen.

Click View =>Windows =>Summary from the main menu or click from the icon bar of the

Abacus Home Page. The Summary screen appears.

& Abacus Manager - [Summary]

% Activity

z [alo)
Please click here for License detais
Unassigned
@Events
-Mone-
?/Get Help

% Contact

Contact Abacus at 1-877-879-2721
ermail: abacussupport@mirrorplus.com

Figure 86: Summary Screen
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Searching Summaries
You can filter the summaries. To do this, follow the given procedure.

1. To get specific summary reports:

= You can click numbers beside Total Billed and Total Unbilled, you can get
detail report of the billed and unbilled activities.

= Select All or Unassigned from the adjacent drop-down list. This enables you to

get detail summary report of all the activities and also the unassigned ones
depending upon your selection.

2. Click Filter to allow filtration.

Figure 87: Filtering summary reports

Removing Summary Report
Follow the given procedure to remove the summary report.

1. Select the summary report from the list of activities.

2. Click Clear. The selected summary gets removed from the list.

Exporting Summary Report
Follow the given procedure to export summary report.

1. Select the summary report that you want to export from the list of activities.
2. Click Export. The Save As dialog box appears.

3. Select the location where you want to export the file and enter a file name in the File
Name text box.

4. Click Save. The selected report(s) get exported to that specific file.

From Summary screen you can also get detail information about your Abacus License, Events and
Contact Details. You may click the Help icon if any relevant help is required for Abacus Manager.
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Chapter 7
Abacus Devices

By default, abacus tracks every windows printer on your network. The Abacus Device manager allows you
to select the devices you want to track, as well as define the tracking options.

Accessing Device Screen

Follow the given procedure to access the Device screen.

Click View >Windows >Reports from the main menu or click from the icon bar of the Abacus

Home Page. The Devices screen appears.

The Abacus Device Manager is divided into two frames. The left hand frame contains the Device List and
the right hand frame contains the Device Options.

T peist Peocnarar [kvDAD, POV, # et jba
T st i

S0 Be Epdk.

Figure 88: Abacus Device Manager
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Prerequisites: Before you add a device to Abacus, you may first need to define the media choices that will
be available on the device.

If this has not yet been defined, please refer to that section of this manual first, before you enter a device in
the system.

Adding aNew Device

To add a new device to the Abacus Manager, right-click on Custom Devices, and select the option Add

New Device.

i Tracki Add Mew Device |
i Copy Terminals

Figure 89: Add New Device option

The Add New Device dialog box appears.

X

Add Mew Device

Enter a Frendly name for this Printer

|><eru:u:-d

E nter Printer Mame

|><eru:|:-: ﬂ

Add Close |

Figure 90: Add New Device dialog box

You may name the printer in friendly terms, as you may use when referring to the printer with a Co-worker.
Once defined, you may then either type in the UNC name for the printer.

Enter the printer name or select it from the Enter Printer Name drop-down list. The meaning of each option
is explained below:

Local Printers: Local Printers are installed and are currently available to the computer which is running
the Abacus Manager.
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Network Printers: Network Printers are managed by the machine which is running the Abacus Manager,
and have been shared on the Network.

Remote Printers: Remote Printers are managed by other machines in your network which are available to

the machine that is running the Abacus Manager.

# \ Depending on the size of your network, and the number of printers available, this selection may take
- some time to populate the list.

Previously Connected Printers: Choosing this option will populate the drop-down list with every printer
that has ever been defined in the Abacus Manager in the past.

You may choose any combination of options to narrow or expand your search.

After you selected the printer that you want to add, click Add to record the information to the database. The
Custom Device Window then allows you to set some advanced options for the printer.
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Ed Abacus.”

[xerox

jiiii i

% Drint Procezszar {AutoCAD, PDF. etc print jobs)

 Brint Notificstions

Add Mew Media...

¥ Track this Printer

Save Changes... ) Celste this Device... :EJ
] i 5]

Default Media

Abacus Manager Version 3050
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Modifying a Device

You may change the default options for a selected device in the Device Options frame on the right hand
side of the Devices Window. The following options are:

Friendly Name |XE[D)( |

Printer Name |}(Erlj)( |

FM Managed

Location Key

Provider Key

Serial Number

Device Group

Min Print Width

Max Print Width
Min Print Length
Max Print Length

Process Color Pages

—Iiiii i

Monitor Type ™ print Processor {AutoCAD, PDF, etc print jobs)

" Print Notifications

Active Media Types g
¥ Add New Madia... Default Media

Options W Track this Printer

Szve Changes... Celete this Device...

Figure 92: Modify Devices screen

= Friendly Name: Frequently, printer names can be confusing. You may enter a friendly name
for this device to make it easier to identify a particular printer.

=  Printer Name: UNC name of the printer on your network.

= FM Managed: The ‘FM Managed’ check box is provided for the reporting purposes. It keeps
track of the printing devices, which are managed by the Facility Management.

= Location Key: If there are number of offices (branches) in a location and each location has a
printer, we can club all the individual activities in each location into a single activity by
assigning the’ Location Key'. Example: HDR having many locations.

= Provider Key: One company in many locations with number of printers, we can club them
into a single activity by assigning the ‘Provider Key'. This helps while creating an E-Premier
account.
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= Serial Number: You can keep a track of a print through a device by its ‘Serial Number'. E.g.
If you have 10 same ‘Xerox Regal with Splash RIP’ printers, you can easily track a print by
putting the device’s ‘Serial Number'.

= Device Group: You can club the available devices into a group for tracking purposes.
= Process Color Pages: You need to tick the check box if you are processing color copies.
= Monitor Type: There are two ways that a printer may be tracked by Abacus.

e Print Processor: Many plotters work with unique languages that require
additional processing in order to extract information on size and copies. You
are also required to select the Abacus Print Processor if the printer is local to
a user’s workstation.

e Print Notification: With the Print Notification, Windows will retrieve
information regarding the size and number of prints produced from your
printer. This option works well for printers which use standard Windows
drivers with PCL or Postscript data.

= Active Media Types: You may enable or disable a media choice for a given printer by
selecting the check box next to its name. You can also add a Media type using the link Add
New Media. If a new media is added for a particular printer, it will automatically become
available for other printers in the Abacus database. Media types may also be defined in the
Media section described later in this manual.

= Default Media Type: When a user sends a print job, the Abacus Billing Pop-Up assumes the
default media type. You may set this value to any available media type.

= Options: You can enable or disable the tracking of a chosen printer by selecting or
deselecting the check box as per requirement.

Click Save Changes to save your changes, or click Delete This Device to remove this printer from
Abacus.
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Tracking Devices
The tracking devices represent all the devices that are being tracked by Abacus.
Configuring Devices
You can configure and manage multiple tracking devices at a time. To do this, right-click on Tracking

Devices and click Configure Devices from the extended menu. The Configure and Manage Tracking
Devices window appears.

Configure and Manage Tracking Devices _|
Manage Tracking Devices
Configure and Manage Tracking Devices

Configure Tracking Devices Manage multiple device tracking

Select Computer where Tracking is running

Select Remote Host | Amabhata j

List of devices
Find Matching Devices

Loak far | Find | Clear Search

F.emote Host Device Name
Yaryabhatalxerox Regal with Spla. .. jAryabhata
YaryabhatalCanon Eubble-Jet B3-... iAryvabhata

Clear selection | Select All

Change tracking for selected devices

Start Tracking Stop Tracking Delete |

Change monitoring twpe on selected devices ([Eig e

Change Friendly Mame Apply media
Friendly Name Media Name Pricin. ..
Letter Sheet

[] Bond Sheet
Change
Apply zelected media
< >

(u] 8 I Cancel | |

Figure 93: Configure and Manage Tracking Devices window
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Copiers need to be added under copy terminals using Abacus Manager. This is in order to track the

copiers using Abacus.

Adding Copy Terminal

Follow the given procedure to add copy terminal.

1. Right-click on Copy Terminals and click Add Copy Terminal. The Add new copier

2.

device window appears.

Add new copier device

Enter a Friendly Mame for thiz Printer

#Add Copy Tracking

Enter Copy Tracking Details.

Enter Printer M ame

Tracking Options
[v Track Copies

[v Chooze Page Sizes

v Track Scans

[~ Online Login

|First Floor Ricoh |F|ic:oh Aficio 2030
M achine Seral Mumber IP &ddress
|M21 537246636 |1 0.00.219
Copyp Tracking Type Copy Box Mame [Machine name or IP address)
|RICOH-ESA | |
Copier User Experience
Field Mames Walidation Sort Option Dizplay Option
r | = | [
¥ PIN Mods |Alwa_l,ls j |,e3,2 j Alldbacus Use
IV Project |Alwa_l,ls j |Name ﬂ
Mame
[~ Phase | J | J Wurmber
. Hame[Mumber]
[ Biling Code | =l | =l MumberMarms
[ Motes | J

[ Track Reprints

Add Close

Figure 94: Add Copy Tracking window

Enter a friendly name in the Enter a Friendly Name for this Printer text box to easily

identify the device.
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3. Enter the printer name in the Enter Printer Name text box. For example, Ricoh Aficio
2090.
Enter the serial number of the copier device in the Serial Number text box.
Enter the IP address of copier device in the IP Address text box.

You can select the device from the Copy Tracking Type drop-down list

N oo g &

If the Abacus Copy Tracking application is installed in the different machine and not in
the Copier, then you have to provide the Host Name or the IP address of that machine in
the Copy Box Name (Machine name or IP address) text box.

8. Billing dialog box
Each field has the following options:

= Check box — Select the check box to enable the field. If you select a field, that
particular field is displayed on the billing dialog box.

= Validation — This field indicates how the billing dialog validates a field. The
following are the validation options:

¢ Always — Selecting this indicates validation is mandatory for all activities (all
print / copy /fax / scan jobs)

e Optional — Selecting this indicates validation is not mandatory.
= Sort Option — This field indicates how you want to arrange the data.
e ASC - Selecting this indicates the data is arranged in ascending order.
e DSC - Selecting this indicates the data is arranged in descending order.
= Display Option — This field indicates how the data is to be displayed.

¢ All — Selecting this indicates the data is displayed to all the users in the
Abacus database.

e All-Abacus Users — Selecting this indicates the data is displayed to all the
users except default Abacus users such as Admin, Master Admin users.

e Select one of the modes. You can either select User Mode or PIN Mode.

9. Copier User Experience: In the User Mode, the user is validated based on user name
and password. The user’s names will be displayed in a drop-down list and password
entered by user will be validated against the user name.

a) Inthe PIN Mode, the user is validated based on the PIN numbers that they enter.

b) The optional fields include, configuring projects, phase, billing code, and  notes. You
can select as many fields as you require.

¢) For configuring project, select the Project check box.

e Select the Validation option and the Sort Option.
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e Select the Display Option. This indicates how you want to display the project
Name or Number or Name (Number) or Number (Name).

d) For configuring project phase, select the Phase check box.

e Select the Validation and the Sort Option.

e Select the Display Option. This indicates how you want to display the phase
Name or Description or Name (Description) or Description (Name).

e) For configuring billing codes, select the Billing Code check box.

e Select the Validation and the Sort Option.

f) For configuring notes, select the Notes check box.

e Select the Validation and the Sort Option.

g) Select the Display Option. This indicates how you want to display the comments
section. If you select Global Notes List, the notes field is displayed as a drop-down list.
Users can only select notes from the list. If you select Text Field, notes field is displayed
as a text box. Users can enter their comments in the text box.

10. Tracking Options

e Track Copies: If you select ‘Track Copies’ check box, the device will track
all ‘Copies’.

Track Scans: If you select ‘Track Scans’ check box, the device will track all
‘Scans’.

e Track Reprints: If you select ‘Track Reprints’ check box, the device will
keep the track of all the reprints selected from the ‘History’ of the device.

e Choose Page Sizes: If you select the option ‘Choose Page Sizes’ then you
can add available page sizes to this device.

e Online Login: If you select the option 'Online Login’ then the device
authenticates your request by confirming the PIN number directly from the
Server. You can find your Project and billing details online, The Billing
information is received directly from the server instead from the ‘Local File’.

o Bill At My Desk: If you select the option ‘Bill At My Desk’ then you do not
have to fill the billing information again and again at the device. Users logon
to the copier and complete the copying activities. Abacus Copy Tracking
delivers the billing popup to the user’s desktop for billing. Users bill the
activities to relevant projects.

11. Click Add. The new device is added under Copy Terminals.
12. Click Close to close the window.

13. Click the newly added device under Copy Terminals to confirm the configuration settings.
The Device screen appears.
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Figure 95: Device screen

14. To modify the configuration settings, click Change Configuration Settings.
15. To confirm the changes, click Save Changes hyperlink.

16. To remove the device, click Delete this Device hyperlink.
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Chapter 8
Abacus Media

The Abacus system allows you to define the media that is available to a particular printer, and then
generate usage or billing reports based upon the number of prints produced per media.

Accessing the Media Screen

Follow the given procedure to access the Media screen.

Click View »>Windows >Media from the main menu or click Medi from the icon bar of the Abacus

Home Page. The Media screen appears. The Media Screen is divided into two parts: The left hand frame
consists of the Media List and the right hand frame consists of the selected Media option when clicked on
specific media from the list of media.

Save Chanasti Calate this Madid.,

5.0.20 i

Figure 96: Media Screen
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Prerequisites: Several items may need to be defined before you can properly set up a new media in
Abacus. These include:

= Pricing Model

= Page Sizes

If these have not yet been defined, please refer to those sections of this manual first, before you enter a
Media in the system.

Adding New Media

Follow the given procedure to add new media.

1. To create a new Media, right click on Media on the media list, and click Add New Media.
The Add New Media dialog box appears.

F"- 1d

Enter new Media Mame
|Bond

5

Add this media to devices

Device Name
Rich Aficia 2090
[ ®erox

Clear Selection | Select al |

add | cancel |

Figure 97: Add New Media dialog box

2. Enter a name for your new media in the Enter new Media Name text box.

3. Select the device name from the list of devices to add the above media to the selected
device(s).

4, Click Add. The media gets added under Media.
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Setting your Mediaoption
For each defined media, you may establish the following options:
Pricing Model

You may determine how abacus is to calculate both the chargeable and billable costs for each media.
Options include: Sheet, Square Footage, Square Foot, or linear.

Sheet Sizes

If you selected “Sheet” as the pricing model, you will be shown a list of available sheet sizes in the system.
When standard sizes have been defined, the Abacus system will “Fit” each print image to the first available
size which will completely contain the printed image. Cost calculations will then be based upon the sheet
size rather than the image size. Sheet Sizes are user definable, please review the section titled “Defining
Sheet Sizes” elsewhere in this manual to learn how to define sheet sizes in the database.

Media Advanced Menu Options
In the media list, you may access other features for a Media by right clicking on its icon. From the

Advanced Media Menu, you may add a New Media, Delete a selected Media, assign the selected media to
a device, or generate a media specific activity report.

-2k Media
g Add Mew Media
= Delete Media

=% | Assign Media to Devices

| Shiowe Ackivity Faor this Media

Figure 98: Media Advanced Menu Options

\ If you make any changes to the Media options, then click the Save Changes link in order to record your
o new information to the Abacus database.
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Chapter 9
Abacus Paper Sizes

The Abacus Manager allows you to establish default sheet sizes which may be use to establish correct
print pricing for output sizes rather than image sizes.

Accessing Paper Sizes Screen

Follow the given procedure to access the Paper Sizes screen.

Click View >Windows >Paper Sizes from the main menu or click from the icon bar of the
Abacus Home Page. The Paper Sizes screen appears, The Abacus Paper Sizes screen is divided into two
frames: The left hand frame lists the Paper Sizes and the right hand frame displays the specific option as
selected from the list.

# Abacus Manager - [Untitled] [- =]
i File Miew Tools Help

i (3 new FO pelete | £ ¥Refresh [H500e | ]
s ———

X
Bl Paper Sizes Tabloid

: . MetaPrint
o= 4]
N e Abacus.

“i BRCHD
i BRCHE

i Letter
i Tablaid

Description

Units

.0.2.0 | [Pagesize Tl

Figure 99: Paper Sizes Screen
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Creating New Paper Size
Follow the given procedure to create a new paper size.

1. Right-click on Paper Sizes from the Paper Sizes frame and then select Add New Paper
Size. The Add New Paper size dialog box appears as shown.

Add New Paper size x|

Enter new Paper Size

ILetter

Add Cancel

Figure 100: Add New Paper size dialog box

2. Enter a name for your new sheet size in the Enter New Paper size text box. You may
use any naming convention that you wish, although it would be suggested that you
choose standard ANSI or ISO sheet sizes as names so that your users can identify them
for what they are.

3. Click Add to save your new sheet size.
Modifying the Paper Size
Follow the given procedure to modify the paper size.

1. Select the paper size that is to be modified from the Paper Sizes list. This will cause the
sheet size options frame to refresh and display the current options for the chosen size.

2. You can modify these options at any time.
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Importing Paper Sizes

You can import standard paper sizes from the Master List. Follow the given procedure to import the paper
sizes.

1. Right-click on Paper Sizes and then click Import from the list of options. The Enter Data
Import Job Details window appears.

Enter Data Import Job Details E|
; Create Import Job
@ Create animport job to import Data
Job details

Job Name

Import Data l—_l
Import Source b

| Mext » | Cancel

Figure 101: Enter Data Import Job Details window

2. Select the import source from the Import Source drop-down list.

3. Click Next to continue. The Config file source window appears.

Abacus Manager Version 3050
101 of 170



Config file source

@

Configure lmport Job
Select the DataSouce to configure an import job

File Information

Type |Excel A

0
—
Abacus

PRINT COST RECOVERY SYSTEM

X

Path |C:'\Documents and SettingshsabarighDesktoptPaper size sls

D elimiter

Input File has
f* Calumn Header

™ Ma Calumn Header

Uszer Authentication

< Back | Mext » |

[-]

Cancel

Figure 102: Config file source window

Click J (browse button) to locate the actual file.

Select the file type that you want to import from the Type drop-down list.

You must specify if the file you are importing contains “Column Headers”. Column

headers are descriptive fields which normally occur as the first row of data to describe
the contents for each column below it.

Click Next to continue. The Preview Import Data window appears, which displays the

first few records from your file that allows you to select the worksheet containing the
actual project records you wish to import.
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Preview Import Data E|
E Preview Import Job
@ Presviesy an impott job to view Data fram Source
Paper Size... | F2:2 a8 F4: 4 F5:5 F&: 6
Letter
a4
A3
Al
< >

Contactéddress | Contactaddress

Import Options
T Allow Duplicates f* Update Existing

< Back | MHext > | Cancel

Figure 103: Preview Import Data window

8. Select the specific import options from the Import Options section. The options are:

= Allow Duplicates: If you select this option, the data import will create a new
record for each record contained within the file or database. This option should
generally only be chosen when manually importing data into an empty table in
the Abacus database.

= Update Existing: If you select this option, the data will examine the primary key
for each imported record, and check to see if it already exists within the Abacus
database. If it does, the record will update the existing record. If it does not, it will
be considered a new entry into the database.

9. Click Next to proceed. The Field Mappings window appears.
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Destination Fields Source Figlds Freviesy Source Default Column Filte]
Hame F2:2 hd Column Filtg
Width Paper Sizes ;1 | Letter Column Filtg
Height Paper Sizes 1 TILeﬁer Column Fitd
Tolerance Width Mir]_Mone_ - Column Fitd
Tolerance Width MaF2 : 2 ~| Column Fitg
Tolerance Length M _Mone_ ] Column Filtg
Tolerance Length M _Mone_ T Calumn Filtg
Un|its _Mane_ -] ~ | calumn Fits
4 r

R Filter Details

Configure Fow Filters

- Maone -

< Back | Mext = | Cancel

Figure 104: Field Mappings window

10. The Abacus Database records three fields for each project.

Name
Width

Tolerance Width Min
Tolerance Width Max

Tolerance Length Min

Tolerance Length Max

Units

Using the header drop-down list, you can select the appropriate column from your input file that relates to
the required field. As you make your selection, the preview column will display the first record for the
chosen column. It allows you to verify that the correct data is being imported for that field or not.

11. Click Next to continue. The Finish Job window appears as shown.
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Finish, Joh

: Finish Import Job
@ Click Finizh to Save Impott Job

Job Infarmation
Marme: Import D ata: Import S ource:

Cluick Import FageSizes File

Source [nformation

Type: CoHeaders Drelimiter Import Option
Excel Yes Update Existing
Fath

C:A\Documents and SettingshzabamighDesktophPaper size. xls

Field tdapping Information

Source Destination Filker ~
Mame Fz.i2 Mone
Width Paper Sizes ;1 iMone
Height Paper Sizes.: 1 iMone
Tolerance Width ... i None Mone
Tolerance Myidth .. iF2. 2 Tone w

Schedule Infarmation
Mot Scheduled

Advance Option

< Back | Firish | Cancel

Figure 105: Finish Job window

12. The final screen allows you the ability to program certain defaults, which pertain to
records that may be blank within your import data. You may also set the default status for
all the imported projects to Active or inactive, which will enable you to hide new projects
from your users you have had an opportunity to review them.

Manage Paper Sizes Master List

You can import standard paper sizes from the Master List. Follow the given procedure to manage pare
sizes master list.

1. Right-click on Paper Sizes and then click Manage paper sizes Master List from the list
of options.
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Paper Sizes

Add Mew Paper Size
Impaork

% Lel

Figure 106: Paper Sizes option

The Manage master paper sizes list window appears.

Add new Paper Size ‘ odify | Delete |

Description | Size | Units | Tolerance M... | Tolerance M... | Tolerance M... &

LI LETTER 8.5x11 §.50% 11,00 Inches 0.00 0.00 0.00

[ LEDGER 11x17 11.00 % 17.00 Inches 0.00 0.00 0.00

[ aNsI-C 17.00 ¥ 22.00 Inches 0.00 0,00 0.00

C1 ANSI-D 22,00 » 34.00 Inches 0.00 0.00 0.00

[ ANSIE 34.00 ¥ 44,00 Inches 0.00 0.00 0.00

[ ] ARCH-A 9.00 % 12,00 Inches 0.00 0,00 0.00

[ CWERSIZE 12x15 12,00 » 18,00 Inches 0.00 0.00 0.00

[ ARCH-C 16.00 ¥ 24.00 Inches 0.00 0.00 0.00

[ ] ARCH-D 24.00 % 36.00 Inches 0.00 0,00 0.00

[ ARCH-E 36,00 » 48,00 Inches 0.00 0.00 0.00

(1 ARCH-F 30.00 ¥ 42,00 Inches 0.00 0.00 0.00

[]ADB4 x 1189 mm 841,00 X 1159.00 iMilimeters :0.00 0,00 0.00

[1A1594 x84l mm  i594,00 X 841,00 iMilimeters 0,00 0.00 0.00

[] A2 420 x 594 mm 420,00 ¥ 594,00 Milimeters (0,00 0.00 0.00

[ A3 297 x 420 mm 207.00 ¥ 420.00 Milimeters (0,00 0,00 0,00

C1A4210x297 mm  i210,00 ¥ 297,00 iMilimeters 0,00 0.00 0.00

[ 1 AS 148 x 210 mm 148.00 ¥ 210.00 Milimeters (0,00 0.00 0.00 = |

[ ] 46105 x 148 mm 105.00 ¥ 148.00 Milimeters (0,00 0,00 0,00

[1150-B1 707 x 100, i707,00 ¥ 1000,00 iMilimeters 0,00 0.00 0.00

[]150-B2 500 x 707 ...1500.00 ¥ 707,00 Milimeters (0,00 0.00 0.00

[]150-B3 353 x 500 ,..353.00 X 500.00 Milimeters (0,00 0,00 0,00

[1150-B4 250 x 353 ,,,1250,00 ¥ 353,00 iMilimeters 0,00 0.00 0.00

[1C3 324 x 458 mm 324,00 ¥ 458,00 Milimeters (0,00 0.00 0.00

|| C4 229 % 324 mm 229,00 ¥ 324.00 Milimeters (0,00 0,00 0,00 v

< | >
Select All Clear Selection | Import Selected |

Close

Figure 107: Manage master paper sizes list dialog box

2. Select the Paper type that you want to add in ‘Paper Sizes’ and then click Import
Selected. The paper sizes from the master list get imported.
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Units: You can define the base units for your sheet size in Inches, Centimeters, Millimeters, or Pixels.

Dimensions: Once your unit of measure has been defined, you can enter in the values for Width and
Height in the boxes provided.

Tolerance: Print images may end up being just slightly smaller or larger than your defined standard sizes.
You may elect to provide your users with a bit of cushion, to allow for minor size discrepancies. By setting
a minimum and maximum tolerance value, you can tell the system to round the image width or height up or
down so that it can be charged as a standard size. Tolerance values are entered as values in the specified
units and will dictate the maximum measured difference that the system should allow for width or height
when calculating the chargeable size for a print.

Example: Let's say that you have your units set to inches, and have defined a sheet size of 24x36. A user
submits a print with an image size of 23.5” x 37".

With the min value set to .5 and a max value set to 1 this image would be calculated as a 24 x 36.
However, if the min were less than .5 and or the max value was less than 1, then the system would search
through the paper size list to find the next smaller or larger defined sheet size which would fully contain the
image.

# \ If you make any changes to the Media options, please be sure to click on the link labeled “Save Changes”
- in order to record your new information to the Abacus database.
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Chapter 9
Abacus Pricing

Abacus contains very sophisticated pricing features, which allows you to generate reports that include cost
or charge information for billing clients or determining overhead costs for printing on a project.

The system is designed in such a way that you may create standard price catalogs, which can easily be
applied to new projects or print reasons, or can be customized for projects that may have unusual pricing
requirements for printing.

Accessing Pricing Screen

Follow the given procedure to access the Pricing screen.

'®

Click View >Windows =>Pricing from the main menu or click | *19M3"| from the icon bar of the Abacus
Home Page. The Price Catalog screen appears. There are two types of price catalogs:

= Corp Codes: Corp Codes can be created to reflect billing codes that may
already be established as part of your in-house accounting system. A Corp Code
is then attached to a pricing model which will allow you the ability to display
accounting codes in reports that you generate with Abacus. To view the Corp
Code editor, click on the Corp Code icon from the Pricing List.

= Price Catalogs: There are many factors which can impact the cost of printing.
Some or all of them may be present in the way that your firm chooses to bill for
this service. For this reason, Abacus has been designed to allow for the most
common types of billing scenarios.

Prerequisites: Several items may need to be defined before you can properly
set up a new Price Catalogue in Abacus. These include:

= Media Page Paper Size Billing Code Corp Code

= Sets Range

Sqft / Sheets Range
Unit Price ($)

Item Code

Abacus Manager Version 3050
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©

If these have not yet been defined, please refer to those sections of this manual first, before you enter a
Price Catalogue in the system.

Corp Codes

Adding New Corp Codes

Follow the given procedure to add new Corp Codes.

1. Click Corp Codes from the Price Catalog section in the left hand panel. The Corp

Codes screen appears on the right hand side.

Corp Codes
Code | Desc TaxR ate
Cost Cost 0.a0
Charge Charge a.00
P Il | B
[ Ead || Remove || Modify

Figure 108: Corp Codes screen

2. Click Add. The Add New Corp Codes dialog box appears.

Add New CorpCode

— Corp Code

Corp Cade |9955

Drescription IIn-H alse

Tax Rate I2

Add Cancel
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Figure 109: Add New CorpCode dialog box

Enter the corporate code in the Corp Code text box.
Enter the description of the corp code in the Description text box.

Enter the tax rate in the Tax Rate text box.

o o M w

Click Add and the information got saved into the database, and the list of codes gets
updated in the editor as shown.

Modifying Corp Codes
Follow the given procedure to modify the Corp Codes.
1. Select the code that you want to modify from the list of Corp Codes.

2. Click Modify. The Modify CorpCode dialog box appears as shown.

Modify CorpCode §|

Corp Code

Corp Code

Deszcription |Eharge

Tax Rate ||:|

| Ilpdate | Cancel

Figure 110: Modify Corp Code dialog box

3. Modify the text fields as per requirement and click Update. The modified fields get
updated.

Removing Corp Code
Follow the given procedure to remove a Corp Code.

1. Select the code that you want to remove from the list of Corp Codes.

2. Click Remove. The selected code gets deleted from the list.
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Price Catalogs

Adding a new Price Catalogue

Follow the given procedure to add a new price catalog.

1. Right-click on the Price Catalogues icon in the Price Catalog section in the left hand

panel.
Price Catalog

@
b

Corp Codes

'

Figure 111: Adding Price Catalog

The Add New PriceCatalog dialog box appears.

Add New PriceCatalog

Enter Mew PriceCatalog Mame

!HaverHiII Congtruction Planzets

Add Eoee ]

Figure 112: Add New Price Catalog dialog box

2. Enter the new price catalog name in the given text box. The name you provide will
generally reflect a customer, project, media, or print use that may be defined by contract
or by office standard.

3. Click Add and the new price catalog gets added in the database as shown.

Price Catalog

- 4gh Corp Codes
[=|-4gh Price Catalogs
HaverHill Canstruction Plansets |

Figure 113: New Price Catalog
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Price Models

When defining a new catalogue, you can establish pricing for any available media or sheet size which has
been defined on the system. Pricing may be defined by one of two different price models depending on
your requirements:

= Flat — Regardless of quantity, pricing will be charged at a standard rate for each sheet,
square foot or linear foot of media printed.

= Scaled — Depending on quantity, pricing will be scaled downward based upon quantity levels
produced.

There are two interfaces available for entering pricing for a catalogue, which depend on the price model
that you have chosen. For a flat price model, you may want to select the Simple Pricing View at the top of
the catalogue editor.

Entering Flat Pricing

In the simple pricing view, you will have the ability to enter a flat price for billable vs. non-billable, first print
(original) vs. copy pricing for each media and size defined on the system. Depending on how many options
are available in your print network, this list may be fairly large. For this reason, a single catalogue may be
associated with several projects in your system.

1. From the new price catalog screen, click Simple Pricing View. The Simple Pricing
View screen appears.

Simpla Pricing view for Havarhill Construction Plansats catalog E
Simple Pricing view for Haverhill Construction Plansets catalog
Shmgle: Pricing view: Tor Haverhil Construction Pansets catalng
Sienpilbe Pricing (Ed
Cost i Charge:
N Non-Hemburzable Hembuizable
Driginals Copirs Nriginals Copirs Driginal: Copiez Nriginals Copies
Bund [SaFt) [E3 [ [ [F (5 [ 1.00 [T
Letterhead (Saft] 045 oS 0,25 0= 045 0,25 0,35 0
Frnler [Sheel) Delault
ARCH € (0,00x0.00] 1.05 07s 3.00 150 1.05 0.75 3.00 150
ARCH D [0.00x0 00) 3T 180 [ T =311} 180 K0 200
ARCH E (0.00x0.00) 218 225 9,00 450 218 225 9,00 450
Letier (11, D0k 50) 0 ns6 1.00 nsn 0z 026 1.00 nsn
T abloid [17.00x11.00) 7o 0.50 200 1.00 07s 0.50 2.00 1.00
I I
[ save |  clowe | cance

Figure 114: Simple Pricing View window
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2. Enter the Non-Reimbursable and Reimbursable pricing under Cost and Charge
section and click Save. The line item pricing that you have defined will be displayed in
the price item listing at the bottom of the Price Catalogue editor window.

Entering Scaled Pricing

Scaled Pricing is added incrementally to the price listing for a catalogue using the Advanced pricing editor.
For each combination of Media, page size, billing code, and corp code, you can define the line items based
upon the quantity of sets or sheets printed. This needs to be repeated for each pricing level that you have

defined for quantity.

For example, let's say that you want to define scaled pricing for Corp Code 1000, reimbursable, bond plots
and wish to define 3 price levels.

= 1-100 sq ft at $0.35 per sq ft.
= 101 -500 sq ft at $0.25 per sq ft.
= 501 and above at $0.20 per sq ft.

Follow the given procedure to enter the scaled pricing.
1. From the new price catalog screen, click Add Price Iltem. The Pricing window appears.
Pricing E]
E Add P_lice Item
Add Price tem

&dd Price

Media

Page Size

Billing Code

Corp Code

Sets Range

Sgft / Shests Range

Uit Price (3]

Item Code

I -

b

| ary

Lol Lol 1l

EEES

|1 To |‘II]I]I]I]

|1 Ta |1nnoo

|n.25

|MF‘T2345

Add Cosz |

Figure 115: Pricing window

2. Select the media from the Media drop-down list.

3. Select the paper size from the Paper Size drop-down list.
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Select the billing code from the Billing Code drop-down list.

Enter the range for sets and sq feet/sheet in the adjacent text boxes respectively.

Enter the unit price and item code in the Unit Price and the Item Code text boxes
respectively.

8. Click Add. The options that you have selected will stay selected, allowing you to merely

enter a new range and price for your second price level.

9. Click Close to exit the Pricing window. All of the defined price items for a price catalogue
will appear in the price item listing screen as shown.

Items
S.No Media  PageSize BillingCode  CorpCode gf:rt gﬁ; Start End  UnitPrice ItemCode Delete Edit
Bond ; :
1 arge ANY Reimbursable Cost 1 100000 1 100000 4.00 Dpel Edit
Bond :
2 Large ANY ANY Charge 1 10000 1 10000  0.00 Del Edit
3 Egr”gi ANY Reimbursable Charge 1 100000 1 100000 3.00 pel Edit
4 Bond ANY LTI Charge 1 100000 1 100000 6.00 Del Edit
Large Reimbursable . — -
3 3444 NOM- Cost 1 100000 1 100000 4.00 Dal  Edit
Large Reimbursable . - -
6 E;”gi 34X 44  Reimbursable Cost 1 100000 1 100000 4.00 Del Edit
5 3444 NOM- Charge 1 100000 1 100000 4.00 Del  Edit
Large Reimbursable . - -
g Egrngi 34 X 44 Reimbursable Charge 1 100000 1 100000 4.00 Del Edit
(s] Bond 11 ¥ 18 Beimhireahls Coct 1 100000 1 100000 300 Ol Edit

Abacus Manager Version 3050
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Modifying Individual Pricing
Follow the given procedure to modify the individual pricing.

1. Select the individual item that you want to modify and click the Edit link adjacent to each

item.
Items
10000 1 10000 0.00 D=l Ed|
ANY In House Q999 il 10000 1 10000 0.00 Deal Edit

Figure 117: Edit Link in Pricing Items

The Pricing window for modification appears.

Pricing |zi
E Modify Price Item
todify Price kem
—Add Price
Media |Bond Ei
Page Size IANY LI
Billing Code IAN\( j
Carp Code Igggg -]
Sets Range I'I T I'I 0oon
Saft / Sheets Range |1 Ta |1 0000
Unit Price [$) ID-DD
Itern Code I
Modfy | Close

Figure 118: Pricing window for modification

2. Modify the fields as per your requirement and click Modify to apply the changes.
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3. Click Close to exit the Pricing window. The modified price item for the price catalogue will
be displayed in the price item listing screen.

Deleting Scaled Pricing
You may delete all the pricing items at one go or may delete individual item(s) as per requirement.

= To delete individual item, select the item that you want to remove from the pricing list and
click the Delete link adjacent to the item.

= To delete all the items at one go, click Remove All Iltems in the price item listing screen. All
the pricing items get deleted after a confirmation message.
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Chapter 11
Abacus Clients

Abacus lists the detail of all the clients using the Abacus Manager.

Accessing Clients screen

Follow the given procedure to access the Clients screen.

Click View >Windows —>Pricing from the main menu or click ; from the icon bar of the Abacus
Home Page. The Clients screen appears. The Abacus Clients screen is divided into two frames: The left
hand frame lists the Client's name and the right hand frame displays the details of the selected client from
the list.

By creating a client list in the system, you can generate usage reports for any client for whom you are
working, regardless of how many projects you may be handling for that client.

Your Client list can be created manually or imported from the external data.

Figure 119: Clients Screen
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Adding Client in the Client List
Follow the given procedure to add client in the client list.

1. Right click on Clients option from the Clients section and click Add New Client from the
advanced options menu.

B i

#dd Mew Client ‘

Impark

Figure 120: Add New Client

The Add New Client dialog box appears.

X

Add Mew Client

Enter new Client Hame

|F'au| b ac]

k. Cancel

Figure 121: Add New Client dialog box

2. Enter the client's name in the Enter new Client Name text box.
Click OK. The name gets added under Client in the left hand panel.

4, Click on the name, you have added. The form appears in the right hand frame where you
may enter the contact details of the client.
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Bl Abacus.

|Pau| Mac

[1981 M. Broadway, Suite 385
|
[Walnut Creek
[ca

[Usa

[[94506

| Paul Mac

[925-049-5100
|
|
[925-049-5101

Delete this Client...

Figure 122: Client Editor screen

5. Enter the required details and click Save Changes to save the information which will be
recorded to the Abacus database. Client Information can be updated or deleted at any

time.

Deleting Client

Follow the either of the given procedure to delete a client.

1. Click on the client and the client’s detail information appears in the right hand frame.

2. Click Delete this Client from the detail form. The particular client and all the information

against him get deleted.

Or,

1. Select the client name that you want to remove from the list.

2. Right-click on it. The advanced option menu appears.
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3. Click Delete Client. The selected client gets deleted from the list.
Importing Client
Follow the given procedure to import client.

1. Select the client you want to import and right-click on it.

- @ Clients
@ W

Add New Client

Delete Client

Figure 123: Import Projects option

The Enter Data Import Job Details dialog box appears.
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Enter Data Import Job Details |ﬁ|
Create Import Job
Q Create an impart jok to import Data
—Job details
Job Mame |E!uiu:k Import
Impart Data I Projects ;I
Import Source I File ;I
< Back Heut » Cancel

Figure 124: Enter Data Import Job Details dialog box

2. Select the type of import you wish to perform from the Import Source drop-down list.

3. Select Next to proceed. The Config file source dialog box appears.
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3

Drelirniter

Input File has
* Colurnn Header
" Mo Caolurnn Headsr

Fath |C:'\D-:u:uments and SettingzhsabarnighD esktophContacts_07_18_2010_0 |:|

|dzer Authentication

< Back | Mewt » |

Cahcel

Figure 125: Config file source dialog box

4. Select the file type that you want to import from the Type drop-down list.

5. Click J (browse button) to locate the actual file.

6. You must specify if the file you are importing contains “Column Headers”. Column
headers are descriptive fields which normally occur as the first row of data to describe

the contents for each column below it.

7. Click Next to continue. The Preview Import Data dialog box appears, which displays the
first few records from your file that allows you to select the worksheet containing the

actual project records you wish to import.
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Preview Import Data @

3 Preview Import Job

@ Previewy an import job ta viewy Data from Source
First Mame... | Middle Ma... | Last Mame... | Company ... | Title: 5 EMail :
Conkack kesk conkack comp stikants
himadri Majumdar ARC INDTA hirnadrir
Hiru 10 Majumder Hirnu10 Inc Lanmm
Hirul1 Majumder Hirnu10 Inc anmm
Himulz Maiumder Hirnu 10 Ing Lanmo
< >

Contactbddress | Contacthddress

Import O ptionz
™ Allow Duplicates {* Update Existing " Sync Data

< Back | Memt = | Canicel

Figure 126: Preview Import Data dialog box

8. Select the specific import options from the Import Options section. The options are:

= Allow Duplicates: If you select this option, the data import will create a new
record for each record contained within the file or database. This option should
generally only be chosen when manually importing data into an empty table in
the Abacus database.

= Update Existing: If you select this option, the data will examine the primary key
for each imported record, and check to see if it already exists within the Abacus
database. If it does, the record will update the existing record. If it does not, it will
be considered a new entry into the database.

= Sync Data: If you select this option, the data will automatically synchronize with
the imported data.

9. Click Next to proceed. The Field Mappings dialog box appears.
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Field Mappings E|
: Map Fields to Import Job
@ Map Fields of impoart job to setup scheduling jok

Click on Fitter button to apply fiter

Mate: Right Click on Filter Button to clean Filter

Destination Fields Source Fields Preview: Source Default Calumn Filte
Projectumber I_Nu:une_ - Column Filtg
Projectame _Mone_ = Column Filtg
ProjectDescription _Mone_ = Column Filtg
ProjectStatus Mane_ (=] MULL + | column Fitd
BillingCode _Mane_ - MULL ~ | column Fit
PriceCatalog _Mone_ = MULL + | Column Filtg
Client _Mane_ = MULL + | Column Fittg
Department _Mone_ = MULL * | Column Filtg
| | 3

Fow Filter Details Configure Row Filkers
- Mone -

< Back | Mext > | Cancel

Figure 127: Field Mappings dialog box

10. The Abacus Database records three fields for each project.

=  Project Number
= Project Name
=  Project Description
= Project Status
= Billing Code
= Price Catalog
= Client
* Department

Using the header drop-down list, you can select the appropriate option from your input file that relates to the

required field. As you make your selection, the preview column will display the first record for the chosen
column. It allows you to verify that the correct data is being imported for that field or not.
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11. Click Next to continue. The Finish Job dialog box appears as shown.

Finish Job

: Finish Import Job
@ Click Finish to Save Import Jok

Jab Information
Mame: Import Data: Import Source:

Cuick Impart Clients File

Source Information

Type: ColHeaders Delimiter Import O ption
Excel Mo Update Exizting
Path

C:ADocuments and SettingshsabamighDesktophContacts_01_18_2010_03_06_15.:4ls

Field Mapping Infomaation

Scheduls Information

Mot S cheduled

Advance Option

< Back | Firizh | Cancel

Source Destination Filker e
Mame Mone Mone
Addressl None ToneE
Addressz TNone Mone
it Mone Mone
Skate Mone: Mone v

&

Figure 128: Finish Job dialog box

12. The final screen allows you the ability to program certain defaults that pertain to records
which may be blank within your import data. You may also set the default status for all
imported projects to Active or inactive, which will enable you to hide new projects from
your users you have had an opportunity to review them.
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Chapter 12
Tools

Tools are located on the Abacus Menu bar. The Abacus tools provide you with the ability to update and or
modify data, interfaces, and module communication settings in the system.

Manager Display Options
1. Click Tools = Manager Display Options. The Login Settings window appears.
Login Settings E|
Login Settings Device Digplay Options
v Enable Auta Login % Diefault

" Friendly Marme

Praject Dizplay Options " Device Group

* Project Name " Location Key
" Project Murmber ™ Provider Key
" Both: Mame [ Mumber |

" Both: Number[ Mame | Phage Digplay Option

{* Phaze Mame

" Phaze Mumber

" Baoth: Mame [ Mumber ]
" Both: Murnber [ Mame )

[ Show by Departments
B

Auctivity
[ Show Activity Total Area ith Ceiling

[ Show Device Friendly Name ok, | Cancel

Figure 129: Login Settings window

2. In this menu, you may set preferences for the Abacus Manager.

= Enable Auto Login — If you select the check box the access to the Manager will
be disabled. For audit purposes, this is not recommended.

= Project Display options — You can select specific option to set the view options
for the project list. You may choose to have projects listed by name, number or
any combination of both.

= Show by departments — You can select this check box to enable you to group
your project list by departments.
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= Device Display Option — Select the specific option to set the view options for
Display Devices by their Location Key, Provider Key, Device Group, or Friendly
Name.

= Phase Display Option — Select the specific option to set the view options for
Phases by their Phase Number, Phase Name or both.

3. Click OK to set the selected options.

Central Server Synch Settings

1. Click Tools =Central Server Synch Settings. The Reset Synch Settings window
appears.

Reset Sync Settings &]

Feszet Sync Status o Abacuz Central Server

By rezetting the Spnchronization status with central server a fresh copy
af all the infarmation is transfered to the central server again

v Projects Total 3, Synced:0 v Devices Tatal:2, Synced:0

v Activities Total1, Synced:0 Iv Media Tatal 4, Synced:0

v BilingCodes Total:3, Synced:0 [v PageSizes Taotal:3, Synced:0
W Clients Total:1, Synced:0 v Departments Tatal:2, Synced:0

v Pricing Total 2, Synced:0

v CustomFields Total:0, Synced:0

Select all Clear Selection |

Save | Cancel

Figure 130: Reset Synch Settings window

2. You can monitor the number of activities which have been synched to the Reprographic
providers Central Server during a specified period. By selecting specific check boxes, you
may individually reset the counts for the various activity types which later enables you to
review the number of activities recorded.

3. Select the activities you want to reset and click Save.
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Add Manual Activity

1. Click Tools =Add Manual Activity. The Register Manual Activity window appears.

Manual Activity FX'
= Register Manual Achivity
Register Manual Lctivity
Job detailz
Job Mame * Job Type ®

[Print 2005 [Frint =l

Status
| Billed ~|

Billing Infarmation
Project List® [ Enable Search Phaze Lizt

|Erricson j | j

Custorn Field

Biling Code *
| Reimburzable j

Originals Uszer Mame Date

1 Admin x| [oarzemo 011515 P |

Motes *

Fricing

CorpCode | UnitPrice | TotalCost =
Cost I
95399

Charge I

-

< | v[]

Frinter and Media Settings Add Cancel |

Figure 131: Manual Activity window

2. In the Job details section:

a) Enter the job name in the Job Name text box. (Mandatory field)
b) Select the job type from the Job Type drop-down list. (Mandatory field)
c) Select the status of the job from the Status drop-down list. (Optional)

3. In the Billing Information section:

i. Select the Enable Search check box to allow exploring.
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ii. Select the project from the Project List drop-down list. (Mandatory field)
iii. Select the phase from the Phase List drop-down list. (Optional)

iv. Select the billing code for the job from the Billing Code drop-down list. (Mandatory field)

V. You can enter the quantity of the original prints and user name in the Original Prints and
User Name text boxes respectively. (Optional)

Vi. Select the date / time when the print was given from the Date drop-down list. (Optional)

To allow the system to track your costs and charges, enter the required information in the
Pricing section.

Click the Printer and Media Settings to establish the advanced options like, printer,
media selection, paper size, machine name, and number of copies from/in the relevant
fields and click OK.

Advanced Options E|

Device Name
|Riich &ficio 2090 |

Media

|Eond j
Width [Ihches) Length [Inches)

12 14

Machine / Ref Mame No of Copies

IMNDTAPPLOSZ-2 1

Figure 132: Advanced Options dialog box

Click Add to add the manual activity details and the data gets recorded in the database.

s Abacus Manager - [Print Activity - Page 1 of 1, Tatal#: 75]

Figure 133: Manual Activity screen

Define Custom Fields

You may also create custom Fields in Abacus. To do this, on the Tools menu, click Define Custom
Fields. The Manage Custom Fields window appears.

Abacus Manager Version 3050

129 of 170



-
—
Abacus

PRINT COST RECOVERY SYSTEM

Manage Custom Fields El
Manage Custom Fields
Create f Manage Custom Fields and values
Create / Edit Custom Field
Mame |F'n:|pusa| Depends on | nane =l
Display Narne |F'roposa| Required |Upllunal j
Type |dropdown =l Sort by |Key -]
Nate:- Creating more than one custom field is not supported at this time. |f more
than ane custom fields is added then only the first one shows up in popup dialag
Cusztom Field List
Select custom field | Proposal 2| Delete Selected
Custom Field ¥ alues
Parent alues Custom Field Yalues
| Key Walue Descripkion
1 es Presentation cost
1o Mo Mok For presentatior
< >
Delete Al Delete Selected Add New Value |

Figure 134: Manage Custom Fields

1. Enter a name, display name in the Name and Display Name text boxes respectively.

2. Select the field type, depending factor, whether optional or required, sorting type from the
Type, Depends on, Required, and Sort By drop-down list respectively.

Click Add New Value and set the Keys and values for your data.
4. Click Create Custom Fields. The custom fields are created.

Click Close to close the window.

Archive and Restore Activities

Archive & Purge Activities

You may want to remove activities from the Abacus database that are no longer needed for general
reports. These activities can either be archived, which is best, or purged from the system.

Follow the given procedure to work on Archive & Purge activities.
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1. Click Tools = Archive & Restore Activities > Archive & Purge Activities. The
Archive Activities window appears.

Archive Activities

! Archive Aclivities
@ Specify start and end dates for the archival process.

Archive Activities

[~ Start Date
| [~
W EndDate
|10/15/2003 |

| st > | Cancel

Figure 135: Archive Activities

2. Select the Start Date and End Date from the pop-up calendar and click Next to continue.
The Archive Options window appears.

Archive Options fg

! Archive Options
@ Specify name and path for the archival file.

Archive to

File Mame |San Diego

Pah  [CY J

Purge
Iv Purge and clean database after archiving

< Back | MNewt > | Cancel

Figure 136: Archive Options window

3. Enter the file name and directory path to store the archived records.

4, Select the Purge and clean database after archiving to clean the database after the
data is archived.

5. Click Next to continue and the Archival Status window appears to show the status.
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Archival Status

! Archival Status
\ Process status

X

Summary

From: 03/01/2010

To: 034052010

D atabagze Mame: San Diego

D atabase Path: C:h
Purge and Clean after Archive: es

Click Archive button to archive the data.

Archive Cancel

Figure 137: Archival Status window

6. Click Archive to archive the data.

7. Click Close to close the window.

\ If you select purge, the filename and directory need not be specified. In the final window, you will be
- shown a summary of the selections that you have made, and if it appears correct, you may then press
[Archive] or [Purge] to complete the action. Archive files have an extension “.aab”

Restore Activities

At some later date, you may wish to restore activity records from an archive. You may use this menu to
import your archived records back into the Abacus database in order to run reports on them.

Follow the given procedure to work on Restore activities.

1. Click Tools = Archive & Restore Activities 2 Restore Activities. The Restore
Activities dialog box appears.
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Restore Activities ﬂ

' Hestore Activities
@ Browese the database file from wwhich to restore.

Browse file name to restore

File Mame | |

% Baclk I Mest » I Cancel

Figure 138: Restore Activities dialog box

2. Locate the “.aab” backup file to restore and then shown a summary of the activity
information contained within the archive.

3. In the final window, you can select an option which will discard any records that already
exist in the database, which is the best option in order to eliminate the possibility of
duplicating records.

4, Click Restore to return the activity items to the database.
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Map Items

Remap Device

Printers will break or be replaced in your network over time. This may have an impact over the clarity of
your reports, as certain activities will be linked to certain printers. In the event a particular printer is
replaced, and you wish to bind existing records for the old printer to this new printer, you may use this tool

to accomplish that task.
1. Click Tools > Map Iltems > Remap Device to access the ReMap Activities to Device

window appears.

ReMap Activities to Device ['5_<|

Source Device [Deleted)
|Eanu:un Or: Thurgday, October 23, 2003 j

Destination Device (Mot Deleted)]

Mote: The Default media and rezpective pricemodels of destination device will be

applied to the activities of the source device
()4 | Cancel

Figure 139: ReMap Activities to Device window

2. Select the drop-downs to select the name of the deleted printer and the name of the new
printer which is to replace it.

3. Click OK to update all impacted activities in the database.
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Remap Projects

Projects may change, or needed to be renamed from time to time. You may use the Remap Projects tool
to associate activities from a deleted project to a new project in this instance.

1. Click Tools > Map Items = Remap Projects to access the ReMap Projects for
Activities window appears.

Remap Project for Activities ; |

Source Progect [Deleted)

| Rienit com Or: Monday, Oclober 26, 2009 -
Destination Project [Not Deleted)

Mote: The Default Phase, Biling Code of Destination Project will be applied to all Activities
related to the Source Project

Figure 140: Remap Project for Activities window

2. Select the deleted source project and the destination project from the respective
drop-down lists.

3. Click OK.
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Unmapped ltems

Activity items may be imported into Abacus which contains details that may not map directly to a field in the
Abacus database. If an imported activity contains a reference to a field which is not defined in the
database, this field will be marked as “unmapped”. You may use this tool to map unknown fields in the
imported data to defined fields in order to preserve the accuracy of your reports.

1. Click Tools - Map Iltems - Unmapped Items to access the Unmapped Items window
appears.

Unmapped ltems ﬁl
Unmapped ltems
Activites with unmapped project tems

Frojects l FPhazes ] Faper Sizes] tedia ] Bilingcodes | Devices ]

Unmapped Projects List

If Project information billed on imported Activity doesnot exist in the
Abacus Project list, it will be added as an unmapped project and the user
iz given an opportunity bo add the orphaned project to Abacus project list
or bill the activity to an already existing project

Tasks
Select All Delete selected Add Selected Project=] to List |

Fe-map abowve selected project(s] to an exizting project selected below

[ Enable search
I =l

Auta Check Re-map Project |

aK | Cancel I

Figure 141: Unmapped Items window

Fields, which may be reconciled with this tool include:

= Projects
= Phases

= Paper Sizes Media
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= Billing Codes

= Devices
Aliases

You can create ‘Aliases’ for the mapping of the media in Abacus Manager. The Third party applications
may have different names for different Media Types; to map these Media Types in Abacus Manager you
can assign a ‘Value’ to them. Example:. If you want to map ‘Large Format Bonds’ to ‘Bond’ in Abacus
Manager, You can give the Value as ‘ LFB’ in Aliases.

Allases ]
FAkaton Lnd

Tyes | LTl I Plaps Vaks |
-

Drdete 5 ele tod _E

Camsben v ihan

Ahas Tiges iij.‘ -I
o e [ e R |

!
Pl g il s | Bored — I

—

Chaen |

Figure 142: Aliases window

Troubleshooting
Activity Queue

You may use the Activity Queue to monitor pending activities by user on your network. Click Tools >
Troubleshooting = Activity Queue to access the View Activity Queue window.
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View Activity Queue &l

Current Activity Qusue

MNarme PendingactivityCount R
[]138.208.10.106
[]DTo4

[[] DM-30CMBCT
[1138.208.21.104

[ 192.165.201.111
[1138.208.32,52

[ 138.208,32,99

[] cH-GPKXOF1-Y
[1138.208.10.71

[ 138.2068.21.61

[ CH-BRAMDOMMAC
[ ] DM-GRETCHEMMACL
[11358.208.92,52
[]138.208.1.56
[1135.208.21. 146
[1138.208.1.16

[ CcHPO1
[1138.208.10.26

OO0 i P P R A e DD L L R I D P e e

Show Dizplay

* Failed Activities Al Activities * M achine nams " Uszer name

Delete zelected Delete All | Refresh Cloze

Figure 143: View Activity Queue window
Toggle the show choices between failed and all to see all pending activities, or only failed activities.

You may also toggle the view to show the machine name or user name related to the pending activities.
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Server Connections

Click Tools = Troubleshooting = Server Connections to access the Abacus Server Information
window.

Abacus Server Information r‘s_<|

Abacus Server Address ||-D'36|hﬂst

Server Pt |50

Test

Connect to remate devices

i+ Using machine narme " Using IP &ddress

Save | Cancel

Figure 144: Abacus Server Information window

You may use this dialog to configure the communications parameters for the Abacus Server. Click [Test] to

confirm the server connections.
Abacus Manager, rz|
Stakus: running
! Server Marme; ARYABHATA
Pork: 80
Version: 3.0, 3.0

Figure 145: Status screen

This confirms the abacus server name, port used and the status of the server.
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Default Options
The Default option helps the price calculation for the total area.
Follow the given procedure to work on default options.

1. Click Tools = Default Options to access the Default Options window.

irirum Size

widh |12 o Lenath |12 inch

kdirirum Sg. Ft.

Total Area 144

Raounding Type

&+ Default [ Az iz )
" Ceiling

" Floor

" 0.5 Rounding

k. Cancel

Figure 146: Default Options window
2. Under the Minimum Size section, enter the minimum length and width in inches in the
Width and Length text boxes respectively.

3. Calculate the minimum Sq Ft and enter the total minimum area in the Total Area text box
under the Minimum Sq. Ft. section.

4. Select the rounding type option from the Rounding Type section. The Options are:

= Default (As is): Displays the exact total area that has been calculated. Example
if the total area is 166.60, default option displays the exact number.

= Ceiling: Displays the higher figure. Example: Suppose the total area is 166.60,
this option will not display the exact number rather it would display 167.

= Floor: Displays the lower figure. Example: Suppose the total area is 166.60, this
option will display 166 only.

Abacus Manager Version 3050
140 of 170



-
—
Abacus

PRINT COST RECOVERY SYSTEM

= 0.5 Rounding: If the total area is above .5 then it displays the higher figure and if
the total area is below .5 it displays the lower one. Example: If the total area is
166.60, it will display 167 whereas, if the area is 166.30, it will display 166.

5. Click OK and the default options get saved in the database.
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Chapter 13
Importing

Importing Projects

If you have an existing database of project information, you may use the Project Import feature to create
your initial Abacus Project List. Follow the given procedure to export project list from an existing database.

1. Click File = Import 2 Projects. The Enter Data Import Job Details dialog box
appears.

Enter Data Import Job Details

Create Import Job
@ Create an import job to import Data
—Job details
Jaob Mame IE!uick Impart
Import Data I Projects ;I
Import Source I File ;I

< Back Meut > Cancel

Figure 147: Enter Data Import Job Details window

2. Select the type of import you wish to perform from the Import Source drop-down list.
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3. Select Next to proceed. The Config file source window appears.

Config file source f‘gl

7 Configure Import Job
@ Select the DetaSouce to configure an import jakb

File Informnation

Type |Excel -

Fath |C:'\D-:u:uments and SettingzhsabarnighD esktophContacts_07_18_2010_0 |:|

Drelirniter

Input File has

* Colurnn Header
" Mo Caolurnn Headsr

|dzer Authentication

< Back | Mewt » | Cahcel

Figure 148: Config file source window

4. Select the file type that you want to import from the Type drop-down list.

5. Click J (browse button) to locate the actual file.

6. You must specify if the file you are importing contains “Column Headers”. Column
headers are descriptive fields which normally occur as the first row of data to describe
the contents for each column below it.

7. Click Next to continue. The Preview Import Data window appears, which displays the
first few records from your file that allows you to select the worksheet containing the
actual project records you wish to import.
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Preview Import Data @

3 Preview Import Job

@ Previewy an import job ta viewy Data from Source
First Mame... | Middle Ma... | Last Mame... | Company ... | Title: 5 EMail :
Conkack kesk conkack comp stikants
himadri Majumdar ARC INDTA hirnadrir
Hiru 10 Majumder Hirnu10 Inc Lanmm
Hirul1 Majumder Hirnu10 Inc anmm
Himulz Maiumder Hirnu 10 Ing Lanmo
< >

Contactbddress | Contacthddress

Import O ptionz
™ Allow Duplicates {* Update Existing " Sync Data

< Back | Memt = | Canicel

Figure 149: Preview Import Data window

8. Select the specific import options from the Import Options section. The options are:

= Allow Duplicates: If you select this option, the data import will create a new
record for each record contained within the file or database. This option should
generally only be chosen when manually importing data into an empty table in
the Abacus database.

= Update Existing: If you select this option, the data will examine the primary key
for each imported record, and check to see if it already exists within the Abacus
database. If it does, the record will update the existing record. If it does not, it will
be considered a new entry into the database.

= Sync Data: If you select this option, the data will automatically synchronize with
the imported data.

9. Click Next to proceed. The Field Mappings window appears.
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Field Mappings E|
: Map Fields to Import Job
@ Map Fields of impoart job to setup scheduling jok

Click on Fitter button to apply fiter

Mate: Right Click on Filter Button to clean Filter

Destination Fields Source Fields Preview: Source Default Calumn Filte
Projectumber I_Nu:une_ - Column Filtg
Projectame _Mone_ = Column Filtg
ProjectDescription _Mone_ = Column Filtg
ProjectStatus Mane_ (=] MULL + | column Fitd
BillingCode _Mane_ - MULL ~ | column Fit
PriceCatalog _Mone_ = MULL + | Column Filtg
Client _Mane_ = MULL + | Column Fittg
Department _Mone_ = MULL * | Column Filtg
| | 3

Fow Filter Details Configure Row Filkers
- Mone -

< Back | Mext > | Cancel

Figure 150: Field Mappings window

10. The Abacus Database records three fields for each project.

=  Project Number
= Project Name
=  Project Description
= Project Status
= Billing Code
= Price Catalog
= Client
* Department

Using the header drop-down list, you can select the appropriate column from your input file that relates to

the required field. As you make your selection, the preview column will display the first record for the
chosen column. It allows you to verify that the correct data is being imported for that field or not.
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11. Click Next to continue. The Finish Job window appears as shown.

Finish Job

E Finish Import Job
@ Click Finigh to Save Import Job

Job Information

Mame: Import D ata: Import S ource:
2 Projects File
Source Information
Type: ColHeaders Drelimiter Import Option
Excel Yes Update Existing

Path
C:\Documents and Settingz\sabarnighDeskiophContacts_01_18 2010 03 06 15kl

Figld M apping |nformation

Schedule Infarmation

MHat Scheduled

Advance Option

< Back | Finigh | Cancel

Source Drestination Filker e
Projectiumber Mong Mone
Projecthame Mone Mone
ProjectDescripbion . i None Mone
ProjectStatu Mone Mone
EilingCode Mone Mone -

X

Figure 151: Finish Job window

12. The final screen allows you the ability to program certain defaults, which pertain to
records that may be blank within your import data. You may also set the default status for
all the imported projects to Active or inactive, which will enable you to hide new projects
from your users you have had an opportunity to review them.
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Importing Windows Users

You can import the windows users from the domain. Follow the given procedure to import the users.

1. Click File = Import 2 Windows Users. The Import Users from Domain window
appears.

Import Users From Domain

—Step | : Select a Domain

| |

—Step |l : Select Servers

ame | In Falder

Step lIl: Select User
ame | Comment | Flags I Ful

<. | |
Select Al | Irpart | Cloze |

Figure 152: Import Users from Domain window

2. In Step 1: Select a domain from the given drop-down list. The list of servers belong to the
domain are displayed in the Select Servers section as shown.
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X

Step | : Select a Domain
—Step |l : Select Servers

Mame In Folder *
ARCIMDEELUPSYRZ1 MPTOC]-IMDIA

ARCINDCTO9S MPTDC1-INDLA —
ARCIMDDY MPTDC1-INDLA

ARCINDSERVER 14 MPTDeC1-INDIA

ARCINDTESSVRIS MPTLC1-IMDLA

ARCIMDTS1EL MPTDC1-INDLA

ARCIMDTSSYRLY  MPTDCL-IMDIA

INDAPPSERYERLY iMPTDCL-IMDIA

INDTACCTOS3-1 MPTLC1-INDIA

INDTADMNOZZ-1 MPTOC1-INDLA

TN T ADMRSMIN-1 PMPTCC 1 -TRIDTA b’

Step lll: Select Users
Mame Comment Flags Ful
< >
Select Al Impart | Close

Figure 153: Import Users from Domain window (List of Servers displayed)

3. Select a particular server. The list of users belong to that server are displayed in the
Select Users section as shown.
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X

Step | : Select a Domain
|MPTOCTINDIA, |

Step |l : Select Servers

Marne In Folder -~
ARCIMNDERLPSYRZ] IMPTOC 1 -TMDIA
AR CIMDCTOSS MPTDC1-TMDIA
ARCINDDY MPTDC1-INDLA
ARCINDSERVER L4 iMPTDCL-IMDIA
ARCIMNDTESSYRIS MPTDCL-TMDIS
ARCIMDTS1S]1 MPTDC1-TMDIA
ARCIMDTSSVRLS IMPTDCL-TMDIA
INDARPPSERYERLY  IMPTDC1-IMDIA
INDTACCTOSS-1 MPTDCL-IMNDIA
IMDTADMNOZZ-1 MPTDC 1-THDTS
TMOTANMMEAN-1 MPTOC 1 -TMNTA he'
Step lll: Select Users
| Marne Comrmenk Flags ~
WUSR_ARCIN. .. iAccount For the Yisual Studio Analyzer ... (66081
SUPPORT_38... iThis is a vendor's account Faor the Help, .. 166051
SQLDebugger  iThis user account is used by the Yisual, ., (66049
Sauray 66049
RameshDY RameshDy 66049
Tt _ARCIN. .. iBuilt-in account For Inkermet Informati. .. (66081
[l THIED ADCTR Fuiilk_in arcmoink Fow annnomon e serace FENS bt

?
Select Al Import | Cloge |

Figure 154: Import Users from Domain window (List of Users displayed)

4. Select the check boxes adjacent to the user’'s name to select the users whom you want
to import from the list of users or to import the entire users click Select All.

5. Click Import and the selected users get imported into the database.
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Importing Paper Sizes

You can import standard paper sizes from the Master List. Follow the given procedure to import the paper
sizes.

1. Click File > Import > Paper Sizes. The Enter Data Import Job Details window

appears.
Enter Data Import Job Details fgl
; Create Import Job
@ Creste animport job to import Data
Job details

Job Name

Import Data l—_|
st -

| MNewt » | Cancel

Figure 155: Enter Data Import Job Details window

2. Select the import source from the Import Source drop-down list.

3. Click Next to continue. The Config file source window appears.
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X

Path |C:'\Documents and SettingshsabarighDesktoptPaper size sls

D elimiter

Input File has
f* Calumn Header

™ Ma Calumn Header

Uszer Authentication

< Back | Mext » |

[-]

Cancel

Figure 156: Config file source window

Click J (browse button) to locate the actual file.

Select the file type that you want to import from the Type drop-down list.

You must specify if the file you are importing contains “Column Headers”. Column

headers are descriptive fields which normally occur as the first row of data to describe
the contents for each column below it.

Click Next to continue. The Preview Import Data window appears, which displays the

first few records from your file that allows you to select the worksheet containing the
actual project records you wish to import.
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Preview Import Data E|
E Preview Import Job
@ Presviesy an impott job to view Data fram Source
Paper Size... | F2:2 a8 F4: 4 F5:5 F&: 6
Letter
a4
A3
Al
< >

Contactéddress | Contactaddress

Import Options
T Allow Duplicates f* Update Existing

< Back | MHext > | Cancel

Figure 157: Preview Import Data window

8. Select the specific import options from the Import Options section. The options are:

= Allow Duplicates: If you select this option, the data import will create a new
record for each record contained within the file or database. This option should
generally only be chosen when manually importing data into an empty table in
the Abacus database.

= Update Existing: If you select this option, the data will examine the primary key
for each imported record, and check to see if it already exists within the Abacus
database. If it does, the record will update the existing record. If it does not, it will
be considered a new entry into the database.

9. Click Next to proceed. The Field Mappings window appears.
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< Back | Mext = | Cancel

Figure 158: Field Mappings window

10. The Abacus Database records three fields for each project.

Name
Width

Tolerance Width Min
Tolerance Width Max

Tolerance Length Min

Tolerance Length Max

Units

Using the header drop-down list, you can select the appropriate column from your input file that relates to
the required field. As you make your selection, the preview column will display the first record for the
chosen column. It allows you to verify that the correct data is being imported for that field or not.

11. Click Next to continue. The Finish Job window appears as shown.
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Finish, Joh

: Finish Import Job
@ Click Finizh to Save Impott Job

Job Infarmation

Marme: Import D ata: Import S ource:
FageSizes File

Source [nformation

Type: CoHeaders Drelimiter Import Option

Eucel Y Update Existing

Path
C:A\Documents and SettingshzabamighDesktophPaper size. xls

Field tdapping Information

Source Destination Filker 2
Mame Fz.i2 Mone
Width Paper Sizes ;1 iMone
Height Paper Sizes.: 1 iMone
Tolerance Width ... i None Mone
Tolerance Myidth .. iF2. 2 Tone w

Schedule Infarmation
Mot Scheduled

Advance Option

< Back | Firish | Cancel

Figure 159: Finish Job window

12. The final screen allows you the ability to program certain defaults, which pertain to
records that may be blank within your import data. You may also set the default status for
all the imported projects to Active or inactive, which will enable you to hide new projects
from your users you have had an opportunity to review them.
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Chapter 14
Exporting

Exporting Data through ePremier

The user can export data through ePremier. Follow the given procedure to export data.

1. From the File menu, click Export = ePremier.

File
Impaork 3
Export r m ePremict
Exit Ackivities
Projects

Figure 160: ePremier menu

The Enter ePremiere Export Details window appears as shown.
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Enter ePremier Export Details
Complete the required fields below to export data for ePremier

Select Export FileT ype
" Astivity Details Fils
&+ Device Summary File

" Other |

Filker
[~ Filter By Keys for Export

Filter Eyp
= r

OR
Filter By Selected Keps

I= Key Mams
~
~
< >
Export File Information
File Path |C.\Documenls and SettingshsabarmighDesktop
File: M e |o12710-022610. 020

Mote:- For comma separated file sxpart, pleass make sure that lsolate
Fieport/Page Sections is checked in the "Export Options" dialog

Date Ranas
Start Date [Included) End Date [Includsd]

1/27/2010 - 202622010 i

Configure Scheduls | Save |

Run Mow | Cancel |

2. Select the export file type from the Select Export File Type section. The options are
Activity Details File, Device Summary File and Others. To select other file type, select
the Other option and click Browse. Select the required file type from the Open dialog
box and click Open and the export file type gets selected.

3. The user can filter the export files depending on the keys.

= Provider key: Provider key is assigned to a company situated in various
locations with a number of printers. We can club them into a single activity by
assigning the ‘Provider Key'. This helps while creating an E-Premier account.

= Location Key: There may be number of offices (branches) in a location and
each location might have a printer. You can club all the individual activities in
each location into a single activity by assigning the’ Location Key'. E.g. HDR
having many locations.

To filter through Provider Key and Location Key, select the Filter By Keys For Export check box to enable
the filtration.

= Select Split By Provider Key option to filter through provider key. The data gets exported for
all the provider keys.

= Select Split By Location Key option to filter through location key. The data gets exported for
all the location keys.

Or,
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You can filter by selected keys. For that you need to select the Filter By Location Key or Provider Key
check box.

= Select the Provider Key option and select the specific provider key(s) from the list of keys.
The data gets exported for the selected key.

= Select the Location Key option and select the specific location key(s) from the list of keys.
The data gets exported for the selected key.

4, Specify the location where you want to export the files. For that, click J (browse
button) and specify the location from the Browse for Folder dialog box.

5. Enter the file name in the File Name text box.
Specify the start date and end date from the Date Range section.

a) Select the Start Date from the pop-up calendar.
b) Select the End Date from the pop-up calendar.

7. Click Configure Schedule to select the date after which the billing will take place.
8. Click Save to save the detail information provided.

9. Click Run Now and the files starts getting exported as per the keys selected by the user.
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Exporting Activities

You can use third party software system for billing or storing your print activity information. The Abacus

Manager provides a simple means to export the data from its database into a delimited file for import into
another system.

1. Click File > Export = Activities and the Enter Data Export Job Details window
appears.
Enter Data Export Job Details g]
! Create new data export job
@ Erter job name and select export data type
Job details
Job Mame |
Export Data | J
Activity Pricing
[ Include Pricing with Acitivity
CorpCode Mame
; Cost
/19999
L Charge
| Mext » | Cancel |
Figure 161: Enter Data Export Job Details window
2. To export particular data type, select Include Pricing with Activity check box and select
the particular Corp Code from the list or else all the activities get selected.
3.

Click Next to continue. The Export Option Page window appears.
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Export Option Page B|

! Create new data export job
@ Select column name

Export Figlds

Column Mame | - Select Al

Job

Type Clear All

Project

Cepartrnent towe Up ‘

Project Number
Phase Marme
Phase Mumber
Dievice Sort
[] Media
Pricing Model
Copies | ﬂ
Criginals Oirder

‘Width
Length | ﬂ
Bill Code
[] Totalarealsg,F) Save Colurnn Order |
[ ] TrackingMode
[] CreateDate

[] PrintBy
1 hlebee

i

Move Down

Column

Reset Colurmn Order |

b

Mate: Lazt columns will be pricing columns.

< Back | Mext » | Cancel

Figure 162: Export Option Page window

4, Select the check boxes adjacent to the fields that you want to export from the Export
Fields list box. You can click Select All to select all the fields within the Export Fields
list box. Click Clear All to deselect all the selected fields within the list box. You can click
Move Up or Move Down to change the field’s place.

5. Select the column from the Column drop-down list that enables to make the exported
data fit within other reports without modifications.

6. Select the sort order from the Order drop-down list.

7. Click Next to continue. The Export Settings Page window appears.
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Export Settings Page E|
! Create new data export job
@ Enter File Information, Expott Options and Fiters

Export File Information

File: Pathy |E:'\T emp J

Filz Mame

User Authentication

Expart Optiors
Colurnn Delimiter Sy Delimiter ﬂ |

[ Replace Column Delimiter with spaces
[ Column Headers

Fow Delimiter tew Line -

Calumn specifier i -

Filter
[v Ewpart &l Activities

Start Date (Included] End Date [Excluded)

| I Fl

Filter By Provider Key Or Location key
[ Filter by Provider key Or Location Key

C Select Key
~

< Back | Mext » | Cancel

Figure 163: Export Settings Page window

From the Export File Information section, enter the file path in the File Path box or click

~_1 (browse button) to select the file path from the Brose for Folder dialog box.
9. Enter the file name in the File Name text box.
10.

To verify user authentication, click User Authentication. The User Authentication
dialog box appears. (Optional)
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B9

User Authentication

Please enter the user credentials to access the netwark resouce
Domairt sermame

|F‘au| Feset

Pazsword

Test Connection | Save Cancel |

Figure 164: User Authentication dialog box
= Enter the valid user credentials in the Domain/Username and Password text
boxes respectively and click Save to save the settings.

From the Export Options section, select the column delimiter from the Column
Delimiter drop-down list. You may select CSV, Tab or Custom Delimiter format for
compatibility with a third party application and set options for row and column settings.

Select Replace Column Delimiter with spaces check box to replace the column
delimiter with spaces.

Select Column Headers check box to set the field names into your file as the first row of
data.

Enter/select the row delimiter and column specifier in/ffrom the Row Delimiter and
Column Specifier box. Column Specifier will specify each column with the symbol
indicated in the box. E.g.(“).

Select the Active Projects Only check box to export the active projects only.

Click Next to continue. The Finish Job window appears.
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Job Information
Nl = Gl uick. Exporl

File: Information

Col Delimiter - C5W Dedini

Col Headers

Path: CATemp

Sarting Order

Selected Fields

Finizh Export Job
Click Finizh to Save Expart Job

Ewport Data;  Activity

Row Delirmiter  Mew Line

Sarting Column

Source

Job

Twpe

Projeck

Project Mumber

Fibmmm Rl

Schedule Information

Mot Scheduled

Advance Option

< Back | Finizh | Cancel
Figure 165: Finish Job window
17. Here, you can check the Job Information and File Information of the Project that you
want to export.
18. Click Advanced Options to configure pre and post program execution. The Pre & Post

Program Execution dialog box appears as shown.
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Configure Pre & Post Program Execution ﬁ]

[v PreJob Execution Option

(" External Program |D: YWSabarni Guha'ARC_Tazk\Abacuszscreenshabacus

™ Abacus Job | J

[v Post Job Execution Options

(+ Esternal Pragram |D:\Sabarni GuhatARC_Taskhbbacuzh3050%8bacusdd IZI

™ sbacus Job | J

Configure | Cancel |

Figure 166: Configure Pre & Post Program Execution dialog box

Select the required options.

= |f you want a particular job to be executed before other jobs, select the Pre Job
Execution Option check box and select the required option. The options are
External Program and Abacus Job. You can choose either of the two options
and select the external program path or the Abacus job as per your requirement.

= If you want a particular job to be executed before other jobs, select the Post Job
Execution Options check box and select the required option. The options are
External Program and Abacus Job. You can choose either of the two options
and select the external program path or the Abacus job as per your requirement.

19. Click Configure to configure the settings.
20. Click Finish in the Finish Job window after completing the required data entry.
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Exporting Projects

If you have an existing database of project information, you may use the Project Import feature to create
your initial Abacus Project List. Follow the given procedure to export project list from an existing database.

1. Click File > Export - Projects. The Export Option Page window appears.

_ 3
Create new data export job
L Select column name
Export Fields
| Column Name | Select Al
¥ Project Number
¥ Project Name Clear &1
¥ Project Description
vl Client Company Name Move Up ‘
¥ Default Biling Code
v Active Status Mowe Down
[v| PriceCatalog
V| Default Phase Sart
[v| Department Colirm

Active Status =

Order
&7 -

Mote: Last columns will be pricing columns.

< Back | Next > | Cancel |

Figure 167: Export Option Page window

2. Select the check boxes adjacent to the fields that you want to export from the Export
Fields list box. You can click Select All to select all the fields within the Export Fields
list box. Click Clear All to deselect all the selected fields within the list box. You can click
Move Up or Move Down to change the field’s place.

3. Select the column from the Column drop-down list that enables to make the exported
data fit within other reports without modifications.

4, Select the sort order from the Order drop-down list.

Click Next to continue. The Export Settings Page window appears.
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Export Settings Page

X

! Create new data export job
@ Ertter File Information, Export Options snd Fikers

Export File Information

File Path |C:\F‘rogram Files\Abacus -
File Name |Abacus
User Authentication
Export Options

Colurnn D elimiter CSY Delimiter -

™ Replace Column Delimiter with spaces
Iv Column Headers

Fow Delimier Hew Line v
Column specifier e -
Filter

¥ Active Projects Orly

< Back | Mext > | Cancel |

Figure 168: Export Settings Page window

6. Enter the file path in the File Path text box or click _J (browse button) to select the file
path from the Browse for Folder dialog box.

7. Enter the file name in the File Name text box.

8. To verify user authentication, click User Authentication. The User Authentication
dialog box appears. (Optional)

User Authentication le

Please enter the user credentials to access the netwark resouce

Domairt sermame

|F‘au| Feset

Pazsword

Test Connection | Save Cancel |

Figure 169: User Authentication dialog box
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=  Enter the valid user credentials in the Domain/Username and Password text
boxes respectively and click Save to save the settings.

From the Export Options section, select the column delimiter from the Column
Delimiter drop-down list. You may select CSV, Tab, or Custom Delimiter format for
compatibility with a third party application and set options for row and column settings.

Select Replace Column Delimiter with spaces check box to replace the column
delimiter with spaces.

Select Column Headers check box to set the field names into your file as the first row of
data.

Enter/select the row delimiter and column specifier in/from the Row Delimiter and
Column Specifier box. Column Specifier will specify each column with the symbol
indicated in the box. E.g.(*).

Select the Active Projects Only check box to export the active projects only.

Click Next to continue. The Finish Job window appears.

Finish Job X

! Finizh Export Job
@ Click Finizh to Save Export Job

Job Information

Name: (K= Export Data:  Projects

File Information
Col Delimiter - C5% Dielimi Row Delimiter Mew Ling

Col Headers =

Path: D:ASabarni GuhahaRC_Task\Abacus
Sarting Order Sorting Column
Selected Fields
Source A

Schedule Information

Not Scheduled

Advance Option

< Back | Finish | Cancel

Figure 170: Finish Job window

Here, you can check the Job Information and File Information of the Project that you
want to export.

Abacus Manager Version 3050

166 of 170



-
—
Abacus

PRINT COST RECOVERY SYSTEM

16. Click Advanced Options to configure pre and post program execution. The Pre & Post
Program Execution dialog box appears as shown.

Configure Pre & Post Program Execution ﬁ]

[v PreJob Execution Option

(" External Program |D: YWSabarni Guha'ARC_Tazk\Abacuszscreenshabacus

™ Abacus Job | J

[v Post Job Execution Options

(+ Esternal Pragram |D:\Sabarni GuhatARC_Taskhbbacuzh3050%8bacusdd IZI

™ sbacus Job | J

Configure | Cancel |

Figure 171: Configure Pre & Post Program Execution dialog box

Select the required options.

= |f you want a particular job to be executed before other jobs, select the Pre Job
Execution Option check box and select the required option. The options are
External Program and Abacus Job. You can choose either of the two options
and select the external program path or the Abacus job as per your requirement.

= If you want a particular job to be executed before other jobs, select the Post Job
Execution Options check box and select the required option. The options are
External Program and Abacus Job. You can choose either of the two options
and select the external program path or the Abacus job as per your requirement.

17. Click Configure to configure the settings.

18. Click Finish in the Finish Job window after completing the required data entry.
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